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WHAT IS
VIRTUAL

REALITY?

Virtual Reality, or VR, is where a Virtual World - a
three dimensional environment or scenario created on
a computer - can be freely explored, experienced and
examined in real time. All  actions occurring in the
virtual world appear in the Superscape Viscape
viewing window, shown below.

Through the use of VR, users can interact with the
virtual worlds, as if they were really there, in "real"
life. Items can be switched on, off and even broken.
The forces of nature, such as gravity, can also play
their part in upsetting the balance of any set tasks.
The beauty of VR is that although set tasks might not
go according to plan, first time, the virtual worlds can
be reset for the users to try again. Therefore, VR proves
to be the ideal medium for training purposes.

VR is also one of the
safest and most cost
effective ways to gain
experience from using
expensive pieces of
equipment, such as robots
and CNC machinery,
before moving onto the
"real" items in question.

Anything can, and quite
often does, happen in a
virtual world. You don't
have to follow any
predetermined paths.
What happens really is up
to you !!
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Superscape Viscape is used as the runtime platform
for showing the virtual worlds, which are loaded as
five separate robot rooms.

These robot rooms contain Denford VR Robots, based
upon true industrial Mitsubishi RV-M1 robots, with all
the operating functions of the real machines.

The Virtual Reality Linker window provides the user
interface for controlling and programming these robots,
along with other devices present in the virtual worlds.

THE DENFORD

VR ROBOT

SOFTWARE.

VR LINKER MAIN

CONTROL  WINDOW.

ROBOT CONTROL

PANEL WINDOW.

SUPERSCAPE

VISCAPE MAIN

VIEWING WINDOW.

EDIT ROBOT

MEMORY WINDOW.
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HOW TO USE

THIS MANUAL.
The printed manuals, together with the on-line helpfile
and hints system, provides a comprehensive guide to
the use of the Denford VR Robot.

A separate printed guide contains information
detailing the installation of the Denford VR Robot
software.

This manual divides, broadly, into 4 areas of study:

� A  quickstart tutorial, designed for those of you who
just can't wait to be thrown in at the deep end.....

� A section describing the features, basic configuration
and use of the Superscape Viscape software.

� The majority of the manual details the many
components and windows of the VR Linker program,
used to control and program the robots in the
virtual worlds.

� A detailed reference section includes explanations
and tips for completion of the tasks in all five virtual
world robot rooms.

Information relating to setting up and using the
Denford Virtual Reality Robot software with a "real"
robot is included in a section of the VR Robot on-line
electronic helpfile.
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CONVENTIONS

USED IN THIS

MANUAL.

Conventions (shortcut commands) used in the manual
follow this format:

When reference to either a left button or right button
mouse click command is omitted, perform one click
with the left mouse button.

For example - Click "File" on the VR Linker window -
means click the left button of the mouse once, when
the cursor is directly pointing over the the File Menu of
the menubar in the VR Linker window.

When a select menu command is requested, the menu
and option names are seperated by a vertical line, for
example - Click "File|Open" - means open the File menu
and click on the Open option.

[Text] - Square brackets containing text are used to
show software screen buttons or qwerty keyboard keys
that require either pressing or clicking on with the
mouse.
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QUICKSTART

TUTORIAL.
STARTING THE SOFTWARE....
Denford VR Robot's successfully installed and you're
ready to go!

To start the software, click on the "Start" button of
your Windows 95 startbar:

Next, click on the "Programs" group, then "VR Robot"
and finally "Start VR Robot" to start the software.

LOGGING ON....
The User Identification window will appear. Click in
the blank dialog box and type in your name (this will
become your personal user name each time you use
the software):
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QUICKSTART

TUTORIAL.
LOADING A ROBOT ROOM....
The VR Linker window is displayed with the message
"No Virtual Room Selected". VR LInker is the program
that lets you control devices in virtual worlds, called
"Robot Rooms", that are open:

From the VR Linker toolbar, click on "File|Run Virtual
World|Robot Room 1".The Viscape window will
appear and automatically open Robot Room 1. All the
Robot Rooms start from within a lift Note that the
display on the VR Linker also changes:

TOOLBAR
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QUICKSTART

TUTORIAL.
FLYING AROUND A ROBOT ROOM....
Many of the devices in the robot rooms can be
operated as if you were in "real life". Don't be afraid
to experiment - the robot room can always be reset!

Click on the lift doors to open them. Now click on the
middle movebar icon, continue to hold the left mouse
button down and gently move the mouse cursor up.
You will start to move forwards into the room:

MOVE FORWARDS AND

BACKWARDS/  TURN

LEFT AND RIGHT

MOVE UP AND DOWN/
HORIZONTALLY LEFT

AND RIGHT

TILT VIEWPOINT

UP AND DOWN

MOUSE

CURSOR

PRESET

VIEWPOINTS

LIST BUTTON

If you lose your bearings, click on the Preset
Viewpoints List button (shown above), then click on
one of the five preset viewpoints described in the
dropdown list to change the view.
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QUICKSTART

TUTORIAL.
SWITCHING ON THE ROBOT....
Find the grey electrical control box, then click on the
power switch - you will hear the robot "nest" (move to
its datum position). To make it easier, a preset
viewpoint is available of the robot control box switch:

The name of the device you've just switched on
appears in the "DEVICE" panel of the VR Linker
window. Click on the [C] button to display the Robot
Teachbox (the control pad for "Robot 1"):

DISPLAY CONTROL

PAD BUTTON
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QUICKSTART

TUTORIAL.
USING THE ROBOT TEACHBOX TO MOVE THE ROBOT....

[PTP]
BUTTON

[MOVEMENT]
BUTTONS

 You can also move the robot by clicking and holding
the left mouse button on a robot axis (the pivot point),
then dragging in the appropriate direction to move the
robot arm.

Click the brown [PTP] button to set
the robot in "point-to-point" mode
(sets the righthand movement
buttons of the Teachbox to
control the robot axes). Use these
light beige coloured buttons to
manually move the robot.

When a move command cannot be
performed (eg, the axis hits its limit
switch) a buzzer will sound.

Click the On/Off switch on the   Robot Teachbox to
switch it "on".
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QUICKSTART

TUTORIAL.
SETTING THE ROBOT POSITIONS....

Click on the "Memory" menu
and check that the "Use
Memory Descriptions" and the
"Warn If Position Exists" options
are switched "on" (indicated by
a tick mark). Click on each
option to switch it "on" or "off"
(shown left).

Move the robot so its arm is horizontally outstretched, using
the Teachbox to control the robot axes:

To save this position in the robot memory, click the
[PS] button, then enter the three digit number "123"
using the Teachbox [NUMBERS] buttons and press
[ENT]. Type in a Robot Position Description in the dialog
box that appears and press the [OK] button to save
the robot position:

Move the robot to a new position. Now click the [MOV]
button, enter the number "123" using the Teachbox
[NUMBERS] buttons and press [ENT]. The robot will
move to the position you just saved.

[PS]
BUTTON

[MOV]
BUTTON

[ENT]
BUTTON

[NUMBERS]
BUTTONS
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QUICKSTART

TUTORIAL.
USING THE ROBOT SCRIPT EDITOR....
Click on "Scripts|Edit Script..." in the Robot Teachbox
window toolbar to display the Robot Script Editor, used
for building robot programs from positions saved in
the robot memory.

Click with the right mouse button in the first box to
the right of the program line number1. Next, click with
the left mouse button on the "Robot Speed" option in
the pop-up menu that appears:

Click with the left mouse button on the number "7"
from the next pop-up menu. The program line you have
just written sets the speed at which the robot will
perform any subsequent commands:
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QUICKSTART

TUTORIAL.
USING THE ROBOT SCRIPT EDITOR....
Click the [Add] button at the bottom of the Robot Script
window to add a new blank program line:

Click with the left mouse button on the program number
"123 - ROBOT ARM OUTSTRETCHED" from the next
pop-up menu. The program line you have just written
instructs the robot to move to position "123":

Click with the right mouse button in the first box to
the right of the program line number2. Next, click with
the left mouse button on the "Move to Position"
option in the pop-up menu that appears:
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QUICKSTART

TUTORIAL.
USING THE ROBOT SCRIPT EDITOR....
Click the [Add] button at the bottom of the Robot Script
window to add a new blank program line.

Continue to build the program adding a time delay of 5
seconds on program line 3 and a nest robot command
on program line 4. Build program lines 3 and 4 using
the same method as for program lines 1 and 2:

To test your "new" robot program, highlight program
line number 1, by clicking the [Rewind to Start] button
on the control panel in the righthand bottom corner of
the Robot Script window. Start the program by
clicking on the [Play] button:

Note - The programs can only be played when the
Robot Teachbox is switched "off". If the Robot
Teachbox is "on", the [Play] button will be greyed out.

To save your program, called a robot script file, click
"File|Save As", enter a filename and press the [OK]
button in the Save As window that appears.

[PLAY]
[PAUSE]

[STOP]

[REWIND TO START]
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QUICKSTART

TUTORIAL.
LOADING THE EXEMPLAR FILES FOR ROBOT ROOM 1.
Note - Exemplar files to complete all the tasks in all
five robot rooms are installed only if specified during
the initial install of Denford Virtual Reality Robot.

To load the robot script file that successfully carries
out the task in Robot Room 1, you must first load the
robot memory that "matches" the robot script file.

Click on "Memory|Load memory from..." in the
menubar of the Robot Teachbox window. Browse and
open the folder numbered "10000" and load the
exemplar memory file. Folder 10000 contains all the
exemplar files required to complete the task in room
1. The completed task files for Robot Room 1 are
installed by default to the following path:
C:\ProgramFiles\Denford\VirtualRobot\Room81\10000.

Click on "Scripts|Edit Script..." in the menubar of the
Robot Teachbox window to display the Robot Script
window.

Click on "File|Open" in the menubar of the Robot Script
window. Browse and open the folder numbered
"10000", then load the exemplar robot script file.

Check that the Robot Teachbox is switched "off".

Click the [Rewind to Start] button, then the [Play]
button on the control panel of the Robot Script
window, to start the program.



STARTING THE VR ROBOT SOFTWARE  -  3.1VIRTUAL REALITY ROBOT - USER'S MANUAL

The easiest way to start the Denford VR Robot
software is through the Windows 95 startbar menu.

If the Denford VR Robot has been installed using the
recommended program groups, the software can be
started by clicking on the following:

- Startbar
- Programs
- Denford (program group name)
- Virtual Robot (program group name)
- Virtual Robot (shortcut to Cim_link.exe)

The program will ask you to log on with your user
name. Click the list button to display the dropdown
list of Virtual Robot users (shown below). Highlight
and click on your user name.

STARTING THE

VR ROBOT

SOFTWARE -
LOGGING ON

WITH A USER

NAME.

To add a new name to the Virtual Robot users list,
simply click in the blank user name dialog box and
type in your name.

DROPDOWN LIST BUTTON.

[OK] BUTTON TO

CONFIRM USER NAME /
OPEN VR LINKER.

DROPDOWN LIST OF

REGISTERED USER NAMES.

USER NAME

DIALOG BOX.

[CLOSE] BUTTON TO SHUTDOWN USER

IDENTIFICATION WINDOW / VR LINKER.
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Logging on as the "Default User" gives immediate
direct access to all the exemplar files required to
complete the tasks in all five robot rooms.

To log on as the "Default User", click the list button to
display the dropdown list of Virtual Robot users, then
highlight and click on "Default User" (shown below).

LOGGING ON AS

A DEFAULT

USER.

Note - Exemplar files to complete all the tasks in all
five robot rooms are installed only if specified during
the initial install of Denford Virtual Reality Robot.

Using the robot rooms as a "Default User":

- When a robot is switched on, the memory required
to complete the room task is automatically loaded.

- To load any exemplar sequence editor or robot
script file to complete the room task, simply use the
"File|Open" options in each respective menubar -
the Open window should automatically display the
contents of the correct folder (default user number
"10000").
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STARTING THE

VR ROBOT

SOFTWARE.

Clicking the [OK] button on the User Identification
window will open the VR Linker window (shown
below).

To load one of the five available virtual worlds, click
on "File|Run Virtual World" in the VR Linker toolbar,
then select and click on the required "Robot Room
Number" from the list (see page 4.1).

SECURITY

DONGLE

CONNECTION.

The Denford Virtual Robot software will not run
without the  Security Dongle (shown below left). Fit
the Denford Security Dongle to the parallel port of your
computer.
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When you log on as a new user of the VR Robot
software, a personal user directory is automatically
created in the folders of any robot rooms you view.

These personal user directories are used to save any
files created, required or saved in the virtual worlds
viewed. All user directories are named with your
personal user identification number.

To view your personal identification number, click
"Help|User Information" (as shown below). Click on
the [OK] button to remove this window.

USER FILES -
STRUCTURE.
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LOCATION OF

PERSONAL USER

DIRECTORIES.

LOCATION OF PERSONAL USER DIRECTORIES.
The personal user directories are stored in the Virtual
Linker folder, for example (by default install):

- C drive (hard disk)
- Program Files folder

- Denford folder
- Virtual Robot folder

- Room 81 folder (robot room 1)
- 1 (personal directory for user 1)
- 2 (personal directory for user 2)
- 3 (personal directory for user 3)
- 10000 (default files directory)

- Room 82 folder (robot room 2)
- Room 83 folder (robot room 3)
- Room 84 folder (robot room 4)
- Room 85 folder (robot room 5)

(Rooms 82 to 85 also contain the default files directory,
along with any required personal user directories,
automatically created when the robot rooms are used).
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Note - Exemplar files to complete all the tasks in all
five robot rooms are installed only if specified during
the initial install of Denford Virtual Reality Robot.

Exemplar files used to complete the tasks in all five
robot rooms can be loaded into the following:

- The Action Editor (see page 6.5).
- The Sequence File Editor (see page 7.3).
- The Robot Memory (see page 4.4).
- The Robot Script Editor (Page 8.9).

For each of the above options, browse for the folder
relating to the robot room being viewed (ie, the "Room
82" folder for robot room 2), then open  folder "10000"
where all the exemplar files required to complete the
tasks are stored.

Note - The exemplar files are not read only - they can
be overwritten. To restore any incorrect or damaged
exemplar files, copy them directly from the
appropriate default user folder ("10000") on the
cd-rom.

LOADING

EXEMPLAR

FILES FOR

COMPLETED

TASKS.
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The VR Linker on-line helpfile and hints system
provides context sensitive help on using all parts of
the  VR Linker program.

Simply press the [F1] on your keyboard to display the
appropriate help pages (when available) for the
window or component currently highlighted. The
helpfile can also be accessed from the Help menu on
the menubar of the VR Linker window.

When you hold the cursor still for two seconds over an
unknown dialog box or button, a pop-up hint label will
appear (shown below).

HOW TO USE

THE ON-LINE

HELP SYSTEM.

Detailed information relating to setting up and using
the Denford Virtual Reality software with a "real"
robot is included in a section of the on-line helpfile.
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HOW TO USE

THE ON-LINE

HELP SYSTEM.

The on-line helpfile system for the Superscape
Viscape software contains a wealth of information
allowing the potential of the viewing software to be
fully maximised.

Access the Viscape helpfile by clicking the Viscape
Menu button, then highlighting and clicking on the Help
option (shown below).

"DISPLAY THE VISCAPE MENU"
BUTTON, LOCATED IN THE LOWER

RIGHTAND CORNER OF THE MAIN

VISCAPE WINDOW. CLICK THIS

BUTTON TO SHOW THE VISCAPE

MENU.
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CLOSING THE

VR ROBOT

SOFTWARE.

To close the VR Robot software:

- Close any active virtual world robot rooms by
clicking on either the "zero" floor button in the lift,
or clicking on "File|Close Virtual World" in the VR
Linker toolbar (as shown below).

If you try to close the VR Linker with a virtual world
robot room still active, a warning window will be
displayed (as shown below).

continued....
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CLOSING THE

VR ROBOT

SOFTWARE.

- Click on the [Close] button in the User Identification
window to finish the shutdown of the VR Robot
software (as shown below).

continued....

- Click on the [Close] button in the VR Linker window
to shutdown the VR Linker program (as shown
below).
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OPENING A
VIRTUAL

WORLD.

Superscape Viscape provides the main window for
viewing any devices and actions in the virtual robot
worlds. The Viscape window is automatically displayed
when any of the five robot rooms  are opened.

To open a virtual world robot room, click "File|Run
Virtual World" in the menubar of the VR Linker
window.

From the "Run Virtual World" menu click on the virtual
world robot room you want to open (shown below).

Superscape Viscape will launch, automatically loading
the required virtual world robot room number.

Note that the VR Linker changes from showing "No
Virtual Room Selected", to displaying "DEVICE" and
"ACTION" panels.
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A virtual world robot room can be closed using the
following methods:

1) Click �File|Close Virtual World� in the menubar of
the VR Linker window to shutdown the currently
running robot room, along with the Viscape
window.

2) Move back inside the lift (using the shortcut
viewpoints, if available) and press floor button �Ø�
(shown below). The Viscape window will remain
open. A �new� robot room can be loaded from within
the lift, by pressing the lift floor button representing
the �new� robot room number to be loaded.

CLOSING A
VIRTUAL

WORLD.

CLICK THE "ZERO"
BUTTON TO CLOSE

THE VIRTUAL WORLD

Note - The VR Linker window cannot be closed when
the Viscape window is open.
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The Viscape window is split into three basic areas, the
largest and most obvious being the viewing area, where
the objects and devices in the virtual worlds can be
seen. Each robot room starts from within a lift - click
on the lift doors to open them.

The viewbar is positioned above the main viewing area,
containing a list of the preset views available for the
virtual world.

The Movebar, used for navigating around the virtual
world and the Toolbar icons, used for configuring and
using Viscape, are positioned below the main viewing
area.

VISCAPE WINDOW -
GENERAL LAYOUT.

VIEWBAR MAIN VIEWING AREA

MOVEBAR TOOLBAR ICONS

VISCAPE WINDOW - GENERAL LAYOUT.
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VISCAPE WINDOW -
THE VIEWBAR.

THE VIEWBAR.
The viewbar contains a number of preset viewpoints
in the virtual world. Viewpoints are particularly useful
for navigating quickly, or regaining position when lost
in the virtual worlds.

To select a viewpoint, click on the viewpoint list
button to display the dropdown list of preset views.
Highlight the required view description you require, then
click the left mouse button to confirm and change the
view (as shown in the righthand panel).

The same viewpoints can also be selected from the
floating Active Viewpoint window, accessible by
clicking on the "Viscape Menu" icon and selecting the
"Select Viewpoint..." option (as shown below).

View 1 is the same as the top description in the
viewpoints dropdown list, View 2 is the same as the
second description down the list, etc....
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CLICK THE

DROPDOWN LIST

BUTTON,

HIGHLIGHT THE

REQUIRED

VIEWPOINT TEHN

CLICK ....

VISCAPE WINDOW -
CHANGING THE

VIEWPOINT.

....TO CHANGE

TO THE "NEW"
VIEWPOINT.
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VISCAPE WINDOW -
THE MOVEBAR.

THE MOVEBAR.
The movebar tools allow you to freely "fly" around the
virtual world, using your mouse. Try to think of the
display in the Viscape window as being the view from
a floating camera head, which you can control using
the three movement icons: vertical, horizontal and
tilting.

Simply click and hold the left mouse button down over
a movement icon, then drag the icon in the
appropriate direction to move, according to the
settings of the icon chosen (as shown in the righthand
panel).

The icon being used will change colour to show which
movement direction you are applying.

As you move your mouse cursor further away from
the icon, whilst keeping the left mouse button
depressed, your speed of movement will increase.

The Vertical Movement icon mimics the
camera moving from side to side, whilst
looking straight ahead.

The Horizontal Movement icon mimics the
camera moving forwards and backwards and/
or turning whilst looking straight ahead.

The Vertical Movement icon mimics the camera
tilting to look up or down.

THE MOVEBAR ICONS.
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VISCAPE WINDOW -
MOVING AROUND

A VIRTUAL

WORLD.

LEFT CLICK, HOLD AND

DRAG THE REQUIRED

MOVEMENT ICON IN THE

DIRECTION YOU WANT TO

MOVE. THE MOVEMENT

DIRECTION IS SHOWN BY

THE ICON ARROWS

CHANGING COLOUR.

THE FURTHER YOU MOVE

THE CURSOR AWAY FROM

THE ICON, THE FASTER

YOU WILL MOVE THROUGH

THE VIRTUAL WORLD.

KEEPING THE CURSOR

CLOSE TO THE

MOVEMENT ICON ALLOWS

PRECISE POSITIONING OF

THE "CAMERA" VIEW.
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VISCAPE WINDOW -
TOOLBAR ICONS.

MENUICONS.
The lower righthand corner of the Viscape window
contains the four toolbar icons....

        - THE LEVEL VIEW ICON.
Click the Level View Icon to reset the tilt angle of the
"camera" view to horizontal, ie, level. The height of
the "camera" view is not affected.

SUPERCITY (INTERNET) ICON.
RESET WORLD ICON.

LEVEL VIEW ICON.

MAIN VISCAPE MENU ICON.

        - THE SUPERCITY (INTERNET) ICON.
Click the Supercity (Internet) Icon to connect to the
Superscape website via an internet connection.

        - THE RESET WORLD ICON.
Click the Reset World Icon to restore the settings of
the currently loaded virtual world back to their default
values.
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VISCAPE WINDOW -
THE MAIN

VISCAPE MENU.

        - THE MAIN VISCAPE MENU ICON.
Click the Main Viscape Menu Icon to display the main
Viscape menu (shown below).

The options available in the main Viscape menu are as
follows:

� Reset World - Click to restore the settings of the
currently loaded virtual world back to their default
values.

� Level - Click to reset the tilt angle of the "camera"
view in the virtual world to horizontal, ie, level. The
height of the "camera" view is not affected.

continued....



4.10  -  THE VISCAPE WINDOW VIRTUAL REALITY ROBOT - USER'S MANUAL

VISCAPE WINDOW -
THE MAIN

VISCAPE MENU.

continued....

� Select Viewpoint... - Click to display the Active
Viewpoints window, from which preset viewpoints
can be selected and applied to the currently loaded
virtual world.

� Display Mode - Click to show the mode in which the
virtual worlds are being displayed, indicated by the
presence of a "tick mark" (shown below).

Some of the modes listed above may be available,
depending on your system:

WinG - May increase the speed of the graphics on
computers without Direct3D hardware acceleration,
but at the loss of some graphics quality.

DirectDraw - Gives the best quality graphics on
computers without Direct3D hardware acceleration.

RGB Emulation - A Direct3D software emulation
mode. Worlds may run very slowly compared to
worlds using any of the other modes. An MMX
enhanced processor may improve performance in
this mode if MMX Emulation mode is not available.

Direct3D HAL - This can provide good graphics and
fast worlds, but it is only available if you have a
Direct3D graphics card and software installed on
your system.

MMX Emulation - Same as RGB Emulation mode
but uses an MMX enhanced processor.

continued....
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VISCAPE WINDOW -
THE MAIN

VISCAPE MENU.

continued....

� Setup... - Click to display the Viscape Setup
window, used to Enable/Disable devices (such as
mouse   control or sound effects) and configure the
viewing screen display options.

� Proportional Control Setup - Click to display the
Proportional Control Setup window, used for
configuring multiaxis movement devices such as a
Spacemouse or joystick.

� Interlace Display - Indicated by the presence of a
"tick mark". Click to select an interlaced display (for
virtual worlds designed to be used with 3d glasses).

� Help... - Click to view the on-line Superscape Viscape
helpfile, containing detailed information on
configuring and using Viscape.

� World Information... - Click to display the World
Information window, containing an explanation, hints
and tips for the currently loaded virtual world (shown
below).

� License - Click to read the Superscape Viscape
license agreement.

� About Viscape... - Click to display the version and
user details for Viscape.

� Go to Supercity - Click to connect to the Superscape
website via an internet connection.
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To switch any sound effects in the virtual world on or
off, click the Main Viscape Menu Icon, then select and
click on the "Setup..." option to display the Viscape
Setup window (shown below).

Select the "Devices" tab. Scroll down the options in
the top window until the Sound settings are visible
(shown below), then click on the [Enable] button to
switch the sound on, or the [Disable] button to switch
the sound off.

Finally, click on the [OK] button to apply any changes
made to the setup.

VISCAPE WINDOW -
SWITCHING ON

THE SOUND.

2) SCROLL DOWN

THE LIST UNTIL

SOUND IS
HIGHLIGHTED.

3) CLICK ON

EITHER THE

[ENABLE] OR

[DISABLE]
BUTTONS.

4) CLICK ON THE

[OK] BUTTON TO

APPLY THE

CHANGES.

1) SELECT THE

DEVICES TAB.
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STARTING THE

VR LINKER.
The VR Linker window is the main link between the
user and the devices and objects in the Viscape
window. You use the VR Linker to control the actions
of chosen  devices present in each of the virtual robot
worlds.

After starting the VR Robot program, logging in your
user name as described in section 2, the VR Linker
window will appear, visible in the top lefthand corner
of your screen.

The VR Linker will display
"No Virtual Room Selected"
because no virtual worlds
(robot rooms) have been
opened, ie, the VR Linker
has not detected any
devices to control. When-
ever the link to a virtual
world is cut the same "No
Virtual Room Selected"
screen will be displayed.

OPENING A
VIRTUAL

WORLD.

To open a virtual world robot room, click "File|Run
Virtual World" in the menubar of the VR Linker
window.

From the "Run Virtual World" menu, click on the
virtual world robot room file you want to open. The
Viscape window will now appear, automatically
loading the correct virtual world, which opens to
display a pair of lift doors.
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SWITCHING ON

THE DEVICES.
When a robot room is loaded, the "No Virtual Room
Selected" message on the VR Linker window is
replaced by the screen shown below. At the same time,
the Viscape window appears, automatically loading the
correct virtual world. All robot rooms start from within
a lift. Click on either lift door to open the lift doors.

ACTIONS -

Pre-programmed
operations or tasks
that can be performed
by devices in the
virtual robot worlds.

DEVICE -

An object, such as a
robot, that can be
controlled in the
virtual worlds, using
VR Linker.

TO START A ROBOT :
Find the rectangular electrical
control box (usually on the
floor) and switch the white
mains power switch on (by
clicking on the switch with your
mouse). You will see and hear
the robot nest (move to its
datum position) automatically.

TO START A LATHE :
Find the large yellow and red
mains power switch at the back
of the machine and switch it
on (by clicking on the switch
with your mouse). The monitor
screen on the front of the
machine will power up and the
guard door will open.

The VR Linker changes to  to
show a DEVICE panel and an
ACTIONS panel. At this
stage, all the smaller buttons
in the device and actions
panels are greyed out.This is
because no devices in the
virtual world have been
switched on.
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VR LINKER -
GENERAL

LAYOUT.

When the first device in the virtual world is switched
on, the name of the device appears in the DEVICE
panel and the green led will stop flashing. Any actions
associated with the device appear in the ACTIONS
panel. In the example below, a robot has been switched
on in the virtual world.

VR LINKER WINDOW - GENERAL LAYOUT.

MENUBAR.

DEVICE

PANEL.

ACTIONS

PANEL.

DEVICE LIST BUTTON -
DISPLAYS A DROPDOWN

LIST OF REGISTERED

DEVICES.

DEVICE CONTROL PANEL

BUTTON - DISPLAYS THE

CONTROL PANEL FOR THE

SELECTED DEVICE.

CLOSE VR
LINKER

PROGRAM

BUTTON.

DEVICE DIALOG BOX - DISPLAYS THE

DEVICE CURRENTLY BEING CONTROLLED

IN THE VIRTUAL WORLD.

ACTIONS LIST BUTTON -
DISPLAYS A DROPDOWN

LIST OF AVAILABLE ACTIONS

FOR THE SELECTED DEVICE.

ACTIONS DIALOG

BOX - DISPLAYS THE

SELECTED ACTION

THAT CAN BE

PERFORMED BY THE

DEVICE.

ACTIONS EDITOR BUTTON -
DISPLAYS THE ACTIONS

EDITOR WINDOW (ADD, EDIT

OR DELETE ACTIONS FOR A
DEVICE).

PERFORM ACTIONS BUTTON - COMMANDS

THE STATED DEVICE TO START THE

DISPLAYED ACTION, IN THE VIRTUAL WORLD.
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VR LINKER -
FILE MENU.

FILE MENU.

The options available in the File menu are as follows:

� Load World File - Displays dialog boxes allowing a
new world (".CIM") file to be loaded (used for
editing robot memories, script files and sequence
files without having to load the virtual world itself).

� Clear World File - Removes the currently loaded world
file from the VR Linker.

� Edit Sequence File - Displays the Sequence File
Editor window. The sequence files on the virtual CIM
and the real CIM share the same (".SEQ") format.

� Run Virtual World - Move cursor to the right to
display a list of the five Virtual World Robot Rooms.
Click on a robot room to open it in the Viscape
window.

� Clear World File - Closes the Viscape window
containing the currently loaded  robot room.

� History - Displays the history of any world files opened.

� Export to Command File - Exports the current list of
actions for all the devices in the virtual world as a
command (".CMD") file, which can be used by
device drivers on a real CIM system. The option will
be greyed out when unavailable.
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VR LINKER -
SERVICE MENU.

SERVICE MENU.

The options available in the Service menu are as follows:

� Reset - Resets all the values and properties of the
currently loaded control link back to their original
default settings.
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VR LINKER -
OPTIONS MENU.

OPTIONS MENU.

The options available in the Options menu are as follows:

� Use Interlocks - Allows any interlocks that have been
entered into the Action Editor to be used when tasks
are performed by the devices.

This option is greyed out (unavailable) unless
interlocks are required in the currently opened
virtual world (see section 6.7 for further
information about using interlocks).
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VR LINKER -
HELP MENU.

HELP MENU.

The options available in the Help menu are as follows:

� Contents - Displays the contents page of the on-line
helpfile.

� About.... - Displays the About information box for
the VR Linker program. Click on the [OK] button to
close the About.... window.

� User Information - Displays the user name and
directory number associted with that user. Click on
the [OK] button to close the User Information
window. Any files required or saved by the user for
particular virtual worlds are saved in their own
directory.

For example, a file saved by user number 3 when
using the first virtual robot world (Room 81) would
be saved to the path C:\Program Files\Denford\Virtual
Robot\room81\3\filename.
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VR LINKER -
THE DEVICE

PANEL.
The DEVICE panel contains the following:

1) The Device dialog box - This dialog box displays the
device currently being controlled in the virtual world.

2) The Device list button - Click this button to display
a drop-down list of registered devices (shown
below). Click on the required device to display it in
the device dialog box.

3) The Device control panel button - Click this button
to display either the robot or lathe control panel,
according to the device shown in the device dialog box.

4) The green LED will light when the device stated in
the device dialog box is active (ie, it is performing a
program or operation in the virtual world).

4) GREEN LED.

2) DEVICE LIST BUTTON.

3) DEVICE CONTROL

PANEL BUTTON.

1) DEVICE DIALOG BOX.
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VR LINKER -
THE ACTIONS

PANEL.
The ACTIONS panel contains the following:

1) The Actions dialog box - This dialog box displays
the action that can be performed by the selected
device.

2) The Actions list button - Click this button to display
a drop-down list of the available actions for the
selected device (shown below). Click on the required
action to display it in the actions dialog box.

3) The Actions Editor button - Click the [E] button to
display the Actions Editor window. The Actions
Editor allows actions to be added, edited or deleted
for the selected device.

4) The Perform Action button - Click the [A] button to
carry out the action diaplayed in the actions dialog
box for the selected device.

4) PERFORM ACTION BUTTON.

2) ACTIONS LIST BUTTON.

3) ACTIONS

EDITOR  BUTTON.

1) ACTIONS DIALOG BOX.
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VR LINKER

- CLOSE

PROGRAM.

To close the VR Linker program, click the close button
on the VR Linker window, followed by the Close
button on the User Identification window:

1

2
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STARTING THE

ACTIONS EDITOR.
The Actions Editor is used to add, edit or delete any of
the action commands that appear in the drop-down
list of actions from the VR Linker.

When different devices are used, the action editor is
also used to manage any interlocks that apply to the
action commands being edited.

To display the Actions Editor window, click the [E]
button in the ACTIONS panel of the VR Linker window.

CLICK THE [E] BUTTON TO

DISPLAY THE ACTIONS

EDITOR WINDOW.
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ACTIONS

EDITOR -
GENERAL

LAYOUT.

Note - When no Interlock settings are available for the
Virtual World, a smaller Actions Editor featuring  just
the Commands Panel is displayed....

ACTION EDITOR WINDOW (FEATURING

COMMANDS ONLY) - GENERAL LAYOUT.

BUTTON TO SAVE ANY

CHANGES AND EXIT

ACTION EDITOR.

BUTTON TO DISCARD

ANY CHANGES AND

EXIT ACTION EDITOR.

COMMANDS PANEL.



THE ACTIONS EDITOR  -  6.3VIRTUAL REALITY ROBOT - USER'S MANUAL

ACTIONS

EDITOR -
GENERAL

LAYOUT.

The Actions Editor (shown below) is split into two main
panels:

1) The Commands panel -  used to add, edit or delete
any of the actions for the device stated in the
device dialog box of the VR Linker window. The
actions listed in the Commands panel of the Action
Editor are the same as the actions listed in the
ACTIONS panel of the VR Linker.

2) The Interlocks panel - used to manage the interlock
settings between the different devices in the virtual
world, for the action stated in the Commands panel.

ACTION EDITOR WINDOW (FEATURING COMMANDS

AND INTERLOCKS) - GENERAL LAYOUT.

1) COMMANDS PANEL. 2) INTERLOCKS PANEL.

BUTTON TO SAVE ANY

CHANGES AND EXIT

ACTION EDITOR.

BUTTON TO DISCARD

ANY CHANGES AND

EXIT ACTION EDITOR.
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ACTIONS

EDITOR -
COMMANDS

PANEL.

The Commands Panel (shown above) is positioned on
the left side of the Action Editor window.

The Commands Panel contains the following:

1) The Commands Action dialog box - This dialog box
displays the current command action that can be
edited or deleted.

2) The Commands Action Number box - This box
displays the number currently assigned to the
action in the commands action dialog box. Each
action must have a different number (ie, numbers
cannot be repeated within the same list of action
commands).

continued....

COMMANDS PANEL - LAYOUT.

4) ADD

BUTTON.

5) EDIT BUTTON

6) DELETE

BUTTON

3) COMMAND

ACTIONS LIST

BUTTON.

1) COMMAND

ACTIONS DIALOG

BOX.

2) COMMAND

ACTIONS NUMBER.
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ACTIONS

EDITOR -
COMMANDS

PANEL.

continued....

3) Command Actions List button - Click this button to
display the drop-down list of current actions (shown
below). Click on the required action from the list
with the left mouse button to display it in the
commands actions dialog box.

4) [Add] button - Click this button to add a "New
Command" to the available list of actions. To
assign a command description, number and program/
script file to the new command click the [Edit]
button.  The new command action will also be added
to the ACTIONS dropdown menu of the VR Linker
window.

5) [Edit] button - Click this button to display the Edit
Command window (shown below). This allows
editing of the command action description, command
action number and the program/script file (the
command action program).

continued....
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ACTIONS

EDITOR -
COMMANDS

PANEL.

continued....

5) To change the command action name, click in the
description dialog box and overtype with the new
name.

To change the command number, click in the
Command dialog box and overtype with the new
number.

Click on the [Browse] button to search for a new
program /script ".txt" file.

Click on the [OK] button to confirm and apply any
editing changes made to the command editor and
close the Edit Command window.

Click on the [Cancel] button to ignore any editing
changes made to the command editor and close the
Edit Command window.

6) [Delete] button - Click this button, followed by the
[Yes] button on ther confirmation screen (shown
below) to permanently remove the command action
shown in the Commands panel dialog box.
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ACTIONS

EDITOR -
INTERLOCKS

PANEL.

For example, the "Hopper into Machine" command
(shown in the screenshot above) dictates that the
robot will move into the lathe. The robot will therefore
"take" the "Lathe Access" interlock "key" to ensure
that the lathe door cannot be closed by the lathe as it
is positioning inside the lathe cabinet.

The Interlocks Panel displays any interlocks used by
the action displayed in the Command panel.

An interlock is a "key" to control the functioning of a
device, important when using multiple numbers of
different devices, such as in CIM systems.  Interlocks
are "held" by an interlock manager and can be "taken"
and "kept" by devices performing actions in the
virtual world.

An interlock can only be assigned to one device at a
time - if an interlock is being used, or kept by a device,
a different device cannot use that particular interlock
at the same time.  Interlocks are used to prevent
devices and machines from conflicting or damaging
each other.
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The Interlocks Panel (shown above) is positioned on
the right side of the Action Editor window.

The Interlocks Panel contains the following:

1) Take Interlock dialog box - This box lists the
interlocks that must be �taken� by the device, in
order to perform the command action shown in the
command panel.

In the example shown above, the device �Robot 1�
must take the interlocks �Lathe Access�, �Robot 1
Control� and �Chuck Access� from the list of free
interlocks in the interlock manager, before it can
begin the command action �Hopper into Machine�,
stated in the command panel (shown on page 6.6).

continued....

ACTIONS

EDITOR -
INTERLOCKS

PANEL.

INTERLOCKS PANEL - LAYOUT.

4) KEEP INTERLOCK

DIALOG BOX.

3) TAKE INTERLOCK

ADD BUTTON.
2) TAKE INTERLOCK

DELETE BUTTON.

7) INTERLOCKS AVAILABLE DIALOG BOX. 8) INTERLOCK LIST BUTTON.

1) TAKE INTERLOCK

DIALOG BOX.

5) KEEP INTERLOCK

DELETE BUTTON.

6) KEEP INTERLOCK

ADD BUTTON.
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continued....

1) By taking �Lathe Access�, the robot can ensure that
the lathe door is left open for it to gain access to
the chuck. Similarly, �Chuck Access� allows the
robot to place the billet in the chuck  without fear of
the machine either closing the chuck or switching
the spindle on.

2) Take Interlock [Delete] button - Click this button to
remove the interlock currently highlighted in the take
interlocks list. To select an interlock, simply click
on it with the left mouse button.

3) Take Interlock [Add] button - Click this button to
add the interlock displayed in the interlock available
dialog box (at the bottom of the interlocks panel) to
the take interlocks list.

4) Keep Interlock dialog box - This box lists the
interlocks that will be �kept� by the device, after
the command action shown in the command panel
has been completed. In the example shown on page
6.6, the �Robot 1� will continue to keep the
interlock �Lathe Access� from the take interlocks
list, after completing the command action �Hopper
into Machine�. The �Chuck Access� interlock is
released so that the lathe can take this interlock
and close its chuck. The �Lathe Access� interlock
is kept by �Robot 1� to prevent the lathe from
closing its machine door with the robot still in the
machine.

continued....

ACTIONS

EDITOR -
INTERLOCKS

PANEL.



6.10  -  THE ACTIONS EDITOR VIRTUAL REALITY ROBOT - USER'S MANUAL

continued....

5) Keep Interlock [Delete] - Click this button to remove
the interlock currently highlighted in the keep
interlocks list. To select an interlock, simply click
on it with the left mouse button.

6) Keep Interlock [Add] - Click this button to add the
interlock displayed in the interlock available dialog
box (at the bottom of the interlocks panel) to the
keep interlocks list.

7) Interlocks available dialog box - This dialog box
displays the current interlock that can be added to
the Take or Keep interlock lists.

8) Interlock list button - Click on this button to display
the drop-down menu of available interlocks.
Highlight and click with the left mouse button on
the required interlock to display it in the interlocks
available dialog box.

ACTIONS

EDITOR -
INTERLOCKS

PANEL.
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STARTING THE

SEQUENCE FILE

EDITOR.

Sequence files are used to link together a series of
preprogrammed actions performed by devices present
in the virtual robot world. As the sequence file plays,
line by line, the stated actions will be performed by
the devices in the virtual world.

The actions and devices used in the sequence file are
the same actions and devices used in the main VR
Linker.

The Sequence File Editor allows complete control in
the playing and composition of these sequence files.

To display the Sequence File Editor window, select
"File|Edit Sequence File" from the VR Linker menubar,
as shown below.
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SEQUENCE

FILE EDITOR -
GENERAL

LAYOUT.

SEQUENCE FILE EDITOR WINDOW - GENERAL LAYOUT.

3) DEVICE

LIST BUTTON.

2) DEVICE

DIALOG BOX.

1) MENUBAR.

4) ACTION

DIALOG BOX.
5) ACTION

LIST BUTTON.

6) DESCRIPTION

DIALOG BOX.
7) SEQUENCE

FILE DISPLAY

WINDOW.

8) SEQUENCE

FILE EDITING

BUTTONS.
9) SEQUENCE FILE

PLAY BUTTONS.

11) [CANCEL] BUTTON.10) [OK] BUTTON.
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SEQUENCE

FILE EDITOR -
MENUBAR.

The Sequence File Editor contains the following:

1) The Menubar - There are two menus on the sequence
file editor menubar:

The File Menu (shown below) - which contains the
following:

� New - Starts a new sequence file.

� Open - Displays the Open file window. Browse
and open any previously saved (".SEQ" format)
sequence files.

� Save - Autosave and overwrite a sequence file
with the last used filename.

� Save As - Display a Save Sequence File
window, allowing the file to be saved with a
specific filename in a specific directory.

� History - Displays the history of any sequence
files opened.

� Exit - Closes the sequence file editor window
without saving any changes.

continued....

FILE

MENU.

LOCATION OF THE ....
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SEQUENCE

FILE EDITOR -
MENUBAR AND

DEVICE PANEL.

OPTIONS

MENU.

LOCATION OF THE ....

DEVICE

DIALOG BOX.

DEVICE LIST

BUTTON.

continued....

1) The Options Menu (shown below) - which contains
the following:

� Add Wait Automatically - The option is "on"
when a "tick" mark" is visible. When the [Add]
button is clicked, to add a new sequence file line,
an extra line containing a wait command is auto-
matically inserted between the two.

The option can be ticked "on" and "off" by
clicking on the "Add Wait Automatically" option
with the left mouse button.

2) The Device dialog box - This dialog box (shown
below) displays the name of the device controlled
by the action stated in the actions dialog box.

3) The Device list button - Click this button to display
a drop-down list of registered devices. Click on the
required device to display it in the device dialog box.

continued....
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SEQUENCE

FILE EDITOR -
ACTIONS PANEL,
DESCRIPTION

PANEL AND

SEQUENCE FILE

DISPLAY.

continued....

4) The Actions dialog box - This dialog box (shown
below) displays the name of the action (to be
performed by the device stated in the device dialog
box) that can be added to the sequence file.

5) The Actions list button - Click this button to display
a drop-down list of the actions available for the
device stated in the device dialog box. Click on the
required action to display it in the actions dialog
box.

6) The Description dialog box - Click in the dialog box
(shown below) to type a descriptive name for the
sequence file.

7) The sequence file display - The sequence file (shown
below) is displayed as a numbered series of lines,
which run chronologically from top to bottom. Each
line contains the nature of the task to be performed,
action, wait, etc.... To highlight any sequence line,
simply click the left mouse button, when the cursor
is directly over the required line.

continued....

DESCRIPTION

DIALOG BOX.

LOCATION OF THE .... ACTIONS

DIALOG BOX.

ACTIONS LIST

BUTTON.

SEQUENCE

FILE DISPLAY.
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SEQUENCE

FILE EDITOR -
SEQUENCE

FILE EDITING

BUTTONS.

continued....

8) The sequence file editing buttons - There are four
buttons (shown below) used when editing a
sequence file:

� [Add] - Click this button to insert a sequence
file line containing the action and device stated
in the action dialog box and the device dialog box.

The information stated in the action and device
dialog boxes form the basis of the data used in
any sequence line you add or edit.

� [Add Wait] - Click this button to insert a wait
sequence line. This instructs the sequence file to
wait a set length of time before moving onto the
next sequence line.

� [Delete] - Click this button to permanently
remove the currently highlighted sequence line.

� [Edit] - Click this button to replace the
information stated in the currently selected
sequence line, for the action and device currently
stated in the action and the device dialog boxes.

continued....

LOCATION OF THE ....

SEQUENCE

FILE EDITING

BUTTONS.
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continued....

9) The sequence file play buttons (shown below) - There
are four sequence file play buttons:

            [PLAY]  [PAUSE]  [STOP]  [REWIND TO START]

� [Play] - Click this button to play the sequence
file from the currently highlighted sequence line
onwards. As the the sequence file plays, line by
line, the stated actions will be performed by the
devices in the virtual world.

� [Pause] - Click this button to pause a sequence
file that is playing. Click the [Pause] button to
resume playing a paused sequence file.

� [Stop] - Click this button to stop the sequence
file playing, at the end of the sequence line
currently being performed.

� [Rewind to Start] - Click this button to return
to the first sequence line of the sequence file.

10)The [OK] button (shown below) - Click this button
to apply and/or save any changes made to the
sequence file and close the sequence file editor
window.

11)The [Cancel] button (shown below) - Click this
button to close the sequence file editor window
without saving any changes.

SEQUENCE

FILE EDITOR -
SEQUENCE

FILE PLAY

BUTTONS, OK
AND CANCEL

BUTTONS.

CANCEL BUTTON.

LOCATION OF THE ....

OK BUTTON.

SEQUENCE

FILE PLAY

BUTTONS.
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SEQUENCE

FILE EDITOR -
EXAMPLE.

The following example shows how to write a new
sequence file from a set of preprogrammed actions:

1) Select "File|New" to display a blank sequence file.

2) Select and check that "Options|Add Wait
Automatically" is "ticked on".

Note - when writing a sequence file, it is often
easiest to add the lines to the file chronologically,
ie, in the actual order you would expect to see them
be performed.

3) Select the device to be controlled, so it is displayed
in the device dialog box. Use the list button at the
right of the dialog box to chose the device.

4) Select the action to be performed, so it is displayed
in the device dialog box. Use the list button at the
right of the dialog box to chose the action.

5) Click the [Add] button to insert a sequence line
containing the information from 4) and 5).

An extra line containing a "Wait" command will be
automatically inserted after your sequence file line.

If a line is incorrect, highlight the incorrect line by
clicking on it with your mouse. Click the [Delete]
button to remove it. Alternatively, change the
information from 4) and 5), then click the [Edit]
button.

6) Repeat steps 3) to 6) for all the actions and devices
required in the sequence you have planned.

7) Click the [Rewind to Start] button, then the [Play]
button. Edit any lines of your sequence file, if
necessary.

8) Save your sequence file by selecting "File|Save As".



THE ROBOT TEACHBOX  -  8.1VIRTUAL REALITY ROBOT - USER'S MANUAL

DISPLAYING THE

ROBOT TEACHBOX.
The Robot Teachbox is used to control the manual
movement, operating functions and programming of
both the virtual robot and a "real" Mitsubishi RVM-1
(when linked to the computer).

Graphically, the layout and appearance of the teachbox
is identical to the Mitsubishi RVM-1 robot teachbox.
Users that can master the use the virtual robot teachbox
can therefore use a "real" Mitsubishi RVM-1 with the
same degree of confidence.

To display the Robot Teachbox window, check that
the name of the robot you want to control is displayed
in the DEVICE dialog box of the VR Linker window,
then click the robot teach box - [C] - button.

2) CLICK THE [C] BUTTON

TO DISPLAY THE ROBOT

TEACHBOX.

1) SELECT THE ROBOT YOU

WANT TO CONTROL, SO IT IS
DISPLAYED IN THE DIALOG

BOX OF THE DEVICE PANEL.

Note - the robot teachbox button is greyed out (not
accessible) if the robot itself is switched off. Click on
the switch at the back of the robot electrical control
box to power up the robot (as shown on page 5.2).
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ROBOT TEACHBOX -
GENERAL

LAYOUT.

ROBOT TEACHBOX WINDOW - GENERAL LAYOUT.

EMERGENCY STOP

BUTTON.
ON / OFF SWITCH.

MENUBAR.

FOUR DIGIT

TEACHBOX DISPLAY.

TEACHBOX KEYPAD.
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To switch the robot teachbox on, click the on/off switch
so it points to the "on" position.

To switch the robot teachbox off, click the on/off
switch so it points to the "off" position.

Pressing the Emergency Stop button will halt any
virtual robot movements.

Note - when a "real" Mitsubishi RVM-1 robot is linked
to the virtual robot software, pressing the Emergency
Stop button on the virtual robot teachbox has
NO EFFECT on the real robot. The real robot will carry
on until the commanded move has been completed !!

TEACHBOX ON.TEACHBOX OFF.ROBOT TEACHBOX -
SWITCHING ON

AND OFF.

ROBOT TEACHBOX -
EMERGENCY

STOP BUTTON.
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ROBOT TEACHBOX -
MEMORY MENU.

The options available in the Memory menu are as
follows:

� Save Memory to... - Displays the Save As window,
allowing the memory to be saved to a set location
as a Robot Memory File (".RTF" format).

� Load Memory from... - Displays the Open file
window. Browse and open any previously saved
Robot Memory Files (".RTF" format).

� Merge Memory with... - Displays the Open file
window. The Merge function allows a saved RTF
file to be combined with the existing Robot Memory
File.

When robot postions with identical position
numbers are found, a Warning window is displayed
(shown below).

continued....
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ROBOT TEACHBOX -
MEMORY MENU.

continued....

Click [Yes] to overwrite the existing robot position
number with the new (displayed) position, [Yes to All]
to overwrite all existing identical robot position
numbers with their new positions, [No] to ignore the
new identical robot position number or [No to All] to
ignore all new identical robot positions.

� Edit Memory... - Displays the Edit Robot Memory
window. This lists all the currently stored robot
positions, with their position numbers, gripper state
(O-open, C-closed) and descriptive comment.

See page 8.10 Edit Robot Memory window for
further information.

� Send Memory To Real Robot - This option is greyed
out (unavailable) unless a "real" robot is connected
to your computer.

� Receive Memory From Real Robot - This option is
greyed out (unavailable) unless a "real" robot is
connected to your computer.

� Use Memory Descriptions - The option is "on" when a
"tick mark" is visible. When a robot position is set, a
window is displayed allowing a written description to
be entered and stored with the robot position.

� Warn If Position Exists - The option is "on" when a
"tick mark" is visible. A warning window (shown
below) is displayed when a robot position is set with
a position number already in use - Confirm whether
to overwrite the current stored position with the
new set position.
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ROBOT TEACHBOX -
OPTIONS MENU.

The options available in the Options menu are as
follows:

� Jog Speed - (1-9) - Displays the current jog speed,
the incremental speed at which the robot will move,
when being manually positioned using the robot
teachbox buttons.

Click on the option to display the Jog Speed
window (shown below). Adjust the slider until the
required jog speed is shown, then press the [OK]
button.

Jog speed - 1 is slow but very accurate at
positioning, whilst Jog Speed - 9 is fast but
inaccurate when positioning.

continued....
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ROBOT TEACHBOX -
OPTIONS MENU.

continued....

� Collision Detection - The option is "on" when a "tick
mark" is visible. The virtual robot cannot "move
through" other objects. If an object is hit by the
robot, a warning sound is emitted and the robot
stops.

� Robot Control Mode - Displays the Real Robot
Options window, allowing you to configure the type
of data to be sent to either the virtual robot, a "real"
robot, or both.

If a "real" robot is not connected to the computer,
each of the four panels should be set to the "Virtual
Robot Only" option and a "tick mark" visible in the
"Only Use VR Robot" box only (as shown below).
This will allow the software to run faster.

� Send Tool Length to Robot - This option is greyed
out (unavailable) unless a "real" robot is connected
to your computer.

continued....
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ROBOT TEACHBOX -
OPTIONS MENU.

continued....

� Set Robot Speed - Displays a numbered "1 to 9"
menu (as shown below), the numbers referring to
the movement speed of the robot, when a move to
position number command is issued.

A small "dot" is shown opposite the current setting
for the robot speed.

To set the movement speed, click on the required
number, 1 is slow but very accurate at positioning,
whilst 9 is fast but inaccurate when positioning.

Do not confuse this with Jog Speed, which is the
incremental movement speed of the robot when
manually positioned using the teachbox buttons.

� Reset Robot - This option is greyed out
(unavailable) unless a "real" robot is connected to
your computer.
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ROBOT TEACHBOX -
SCRIPTS MENU.

The options available in the Scripts menu are as
follows:

� Edit Script... - Displays the Robot Script Editor
window, where robot programs (script files) that use
the positions stored in the robot memory, are
written and edited.

See section 10  for further information on how to
use the the Robot Script Editor.
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The Edit Robot Memory window is accessed from the
"Memory" menu in the robot teachbox menubar.

Clicking on the "Edit Memory..." option displays the
Edit Robot Memory window (shown in the righthand
panel). This lists all the currently stored robot
positions, together with their position numbers,
gripper state (O-open, C-closed) and a descriptive
comment.

The Robot Memory can store between 1 - 629 robot
positions (each with its corresponding 001 - 629
position number).

The [OK] button (shown above) will save any changes
made in the Edit Robot Memory window to the current
robot memory file, then close the Edit Robot Memory
window.

The [Cancel] button (shown above) will close the Edit
Robot Memory window without saving any of the
changes.

ROBOT TEACHBOX -
EDIT ROBOT

MEMORY

WINDOW.
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ROBOT

POSITION

NUMBER.

GRIPPER

OPEN/
CLOSED.

ROBOT

POSITION

DESCRIPTION.

CLOSE EDIT ROBOT

MEMORY WINDOW

SAVING ANY

CHANGES.

MEMORY MENU - EDIT ROBOT MEMORY WINDOW - GENERAL LAYOUT.

ROBOT TEACHBOX -
EDIT ROBOT

MEMORY

WINDOW.

CLOSE EDIT ROBOT

MEMORY WINDOW

DISCARDING ANY

CHANGES.
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To edit any of the stored positions, highlight the
required position from the list shown in the Edit Robot
Memory window, then click the right mouse button to
display the Edit Position menu (shown below).

ROBOT TEACHBOX -
EDIT ROBOT

MEMORY

WINDOW.

The options available in the Edit Position menu are as
follows:

� Edit Position... - Displays the Position Editor screen
(shown in the righthand panel), used to change the
co-ordinate positions, angles and descriptions for
the highlighted robot postion.

The options available on the Position Editor screen
are as follows:

To change the descripion, click in the description
dialog box and overtype with the new text. Note
- the robot position number itself cannot be
changed.

To change the X, Y and Z co-ordinate positions,
click on the "XYZ Positions" tab, then click in the
required co-ordinate dialog box and overtype with
the new value.

To change the Joint Angles positions, click on
the "Joint Angles" tab, then click in the required
angle dialog box and overtype with the new value.

continued on page 8.14....
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ROBOT POSITION

NUMBER.

POSITION DESCRIPTION

DIALOG BOX.

POSITION EDITOR

TABS.

CO-ORDINATE/ANGLE

POSITION DIALOG BOX.

EDIT POSITION MENU - POSITION EDITOR WINDOW - GENERAL LAYOUT.

ROBOT TEACHBOX -
EDIT ROBOT

MEMORY WINDOW.
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continued from page 8.12....

� Edit Position... - The options available on the
Position Editor screen are as follows:

Click the [Show in VR] button to display the
gripper reference point - a small red diamond shape
- which represents the tip position of the robot
grippers. The gripper reference point is used to
show any highlighted or edited robot positions,
without having to move the virtual robot itself.
To hide the red diamond, click on it with the
mouse.

When changes have been made to any co-
ordinate or angle values the [Apply] button will
become active. Clicking the button performs a
Maths check to determine if the value entered
can be reached by the robot. If the value entered
is valid, the button will become greyed out
(unavailable). If the value is not valid, an error
message window is displayed - click the [OK]
button on the error message window and enter a
new value.

Click the [Test] button to move the virtual robot
to any highlighted or edited robot positions.

Click on the [Cancel] button to close the Position
Editor window without saving any changes made
to the robot position.

Click on the [OK] button to save any changes
applied to the robot position and close the
Position Editor window.

The Options available in the Edit Position menu are
continued on the next page....

ROBOT TEACHBOX -
EDIT ROBOT

MEMORY

WINDOW.
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ROBOT TEACHBOX -
EDIT ROBOT

MEMORY

WINDOW.

continued....

� Show in VR - Displays the gripper reference point -
a small red diamond shape - which represents the
tip position of the robot grippers. The gripper
reference point is used to show any highlighted or
edited robot positions, without having to move the
virtual robot itself.

� Move Robot(s) to Position - Moves the virtual robot
and the "real" robot (when connected to the
computer) to the position  highlighted in the list of
stored robot positions.

� Cut - Cuts the highlighted robot position from the
list of stored robot positions.

� Copy - Copies the highlighted robot position from
the list of stored robot positions.

� Paste - Pastes a robot position previously cut or
copied, over (replacing) the robot position currently
highlighted in the list. If a robot position has not
been cut or copied, the button will be greyed out
(unavailable).

� Create New - Creates a new robot position, from a
robot position previously cut or copied. A new    robot
position is placed at the next position number,
immediately following the last robot position in the
currently stored list. If a robot position has not been
cut or copied, the button will be greyed out
(unavailable).

� Delete - Permanently deletes the highlighted robot
position from the list of stored robot positions.
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ROBOT KEYPAD -
ROBOT PART

NAMES.

The following pages detail the keypad functions of the
robot teachbox.

The diagram below shows a Mitsubishi RVM-1 robot,
labelling the sections and joints, named after parts of
the human arm....

GRIPPER.

WRIST

(ROLL).

WRIST

(PITCH).

FOREARM

SECTION.

ELBOW

JOINT.
UPPERARM

SECTION.

SHOULDER

SECTION.

BASE.

SHOULDER

JOINT.

ROBOT

BODY.
WAIST

JOINT.

HAND

SECTION.
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ROBOT KEYPAD -
[INC] & [DEC]
BUTTONS.

[INC] - Increment button.

Click the [INC] button to move the
virtual robot from its current robot
postion number, to the next robot
position number that appears in its
stored robot positions memory.

After clicking the [INC] button, click the
[ENT] button to perform the command.

[DEC] - Decrement button.

Click the [DEC] button to move the
virtual robot from its current robot
postion number, to the previous robot
position number that appears in its
stored robot positions memory.

After clicking the [DEC] button, click
the [ENT] button to perform the
command.
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ROBOT KEYPAD -
[PS] & [PC]
BUTTONS.

[PS] - Position Set button.

Defines the current position of the
robot, with a robot position number of
your choice and adds it to the stored
list of robot positions.

After clicking the [PS] button, enter a
robot position number, then click the
[ENT] button to save the robot position
to memory.

[PC] - Position Clear button.

Permanently removes a robot position
number of your choice from the stored
list of robot positions.

After clicking the [PC] button, enter the
robot position number you want to
permanently remove, then click the
[ENT] button to perform the command.
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ROBOT KEYPAD -
[NST] & [ORG]
BUTTONS.

[NST] - Nest button.

Returns the robot to its origin (datum)
point.

After clicking the [NST] button, click
the [ENT] button to perform the
command.

[ORG] - Decrement button.

Moves the robot to an outstretched
horizontal position used for checking
robot accuracy.

After clicking the [ORG] button, click
the [ENT] button to perform the
command.
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ROBOT KEYPAD -
[WRT] & [MOV]
BUTTONS.

[MOV] - Move button.

Moves the virtual robot to a robot
position number of your choice from
the stored list of robot positions.

After clicking the [MOV] button, enter
the robot position number you want to
move to, then click the [ENT] button
to perform the command.

[WRT] - Write button.

Used on the virtual teachbox to access
the Edit Position window (see page
8.12), for any of the currently stored
positions in the robot memory.

When the cursor is over the [WRT]
button, click the right mouse button to
display the list of robot positions that
can be edited.
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[PTP] - Point-to-point Mode button.
Point-to-point Mode instructs the
virtual robot to jog (move) using its
individual joints (axes) when the
appropriate jog buttons are pressed:
[B+] & [B-]
[S+] & [S-]
[E+] & [E-]
After clicking the [PTP] button, any
subsequent commands will be
performed in Point-to-point Mode.
To cancel PTP Mode, click on one of
the other available movement modes -
Tool or XYZ.

[XYZ] - XYZ Mode button.
XYZ Mode instructs the virtual robot
to jog (move), using the tip of its
grippers as a reference point, for
moving around a three-dimensional X,
Y and Z grid system.
[X+] & [X-]
[Y+] & [Y-]
[Z+] & [Z-]
After clicking the [XYZ] button, any
subsequent commands will be
performed in XYZ grid Mode.

To cancel XYZ Mode, click on one of
the other available movement modes -
Tool or PTP.

Note - The functions of the wrist movement buttons
are not affected by the setting of PTP or XYZ Modes:
[P+] & [P-]
[R+] & [R-]

ROBOT KEYPAD -
[PTP] & [XYZ]
BUTTONS.



8.22  -  THE ROBOT TEACHBOX VIRTUAL REALITY ROBOT - USER'S MANUAL

[TOOL] - Tool Mode button.

Tool Mode instructs the virtual robot
hand to advance or retract at a fixed
height, in the direction in which the
hand is pointing (ie, the robot base
"locks" in position and does not move).

Tool Mode is not a general movement
mode. It should be used for accurate
positioning of the robot hand in a
horizontal plane. The attitude/angle of
the robot hand is fixed at the point
when Tool Mode is selected.

Tool Mode operates using the
following jog (move) keys:

[Z+] & [Z-], [R+] & [R-]

After clicking the [TOOL] button, any subsequent
commands will be performed in Tool Mode.

To cancel Tool Mode, click on one of the other
available movement modes - PTP or XYZ.

[ENT] - Enter button.

Used to confirm commands entered into
the robot teachbox via the keypad
buttons.

After completing all data entry using
the robot teachbox keypad buttons,
click the [ENT] button to perform the
requested command.

ROBOT KEYPAD -
[ENT]&[TOOL]
BUTTONS.
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POINT-TO-POINT MODE -
B+ AND B- DIRECTIONS.

XYZ MODE -
X+ AND X- AXES DIRECTIONS.

+Y

+X
+Z

3D GRID.

X+

X-

ROBOT KEYPAD -
[X+/B+] &
[X-/B-] BUTTONS.

[X+/B+] - Positive X or B button.

In XYZ grid Mode [X+], this button
moves the tip of grippers in a positive
direction along the X axis.

In Point-to-point Mode [B+], this
button moves the robot base at the
currently selected jog speed setting in
the positive direction (clockwise when
viewed from above).

[X-/B-] - Negative X or B button.

In XYZ grid Mode [X-], this button
moves the tip of grippers in a negative
direction along the X axis.

In Point-to-point Mode [B-], this button
moves the robot base at the currently
selected jog speed setting in the
negative direction (anticlockwise when
viewed from above).
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POINT-TO-POINT MODE -
S+ AND S- DIRECTIONS.

XYZ MODE -
Y+ AND Y- AXES DIRECTIONS.

+Y

+X
+Z

3D GRID.

Y+

Y-

ROBOT KEYPAD -
[Y+/S+] &
[Y-/S-] BUTTONS.

[Y+/S+] - Positive Y or S button.

In XYZ grid Mode [Y+], this button
moves the tip of grippers in a positive
direction along the Y axis.

In Point-to-point Mode [S+], this
button moves the robot upperarm
section pivoting around the shoulder
joint, at the currently selected jog speed
setting in the positive direction
(upwards).

[Y-/S-] - Negative Y or S button.

In XYZ grid Mode [Y-], this button
moves the tip of grippers in a negative
direction along the Y axis.

In Point-to-point Mode [S-], this button
moves the robot upperarm section
pivoting around the shoulder joint, at
the currently selected jog speed
setting in the negative direction
(downwards).
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ROBOT KEYPAD -
[Z+/E+/4] &
[Z-/E-/9] BUTTONS.

[Z+/E+/4] - Positive Z or E / 4 button.

In XYZ grid Mode [Z+], this button
moves the tip of grippers in a positive
direction along the Z axis (upwards).

In Point-to-point Mode [E+], this
button moves the robot forearm
section pivoting around the elbow joint,
at the currently selected jog speed
setting in the positive direction
(upwards).

This button is also used for entering
the numerical value [4].

[Z-/E-/9] - Negative X or E / 9 button.

In XYZ grid Mode [Z-], this button
moves the tip of grippers in a negative
direction along the Z axis (downwards).

In Point-to-point Mode [E-], this button
moves the robot forearm section
pivoting around the elbow joint, at the
currently selected jog speed setting in
the negative direction (downwards).

This button is also used for entering
the numerical value [9].

XYZ MODE -
Z+ AND Z- AXES DIRECTIONS.

+Y

+X
+Z

3D GRID.

Z+

Z-

POINT-TO-POINT MODE -
E+ AND E- DIRECTIONS.



8.26  -  THE ROBOT TEACHBOX VIRTUAL REALITY ROBOT - USER'S MANUAL

ROBOT KEYPAD -
[P+/3] & [P-/8]
BUTTONS.

[P+/3] - Positive P / 3 button.

When used as [P+], this button moves
the robot hand section pivoting around
the wrist (pitch) joint, at the currently
selected jog speed setting in the
positive direction. In Point-to-point
Mode this is an upwards direction. In
XYZ grid Mode, the gripper reference
point is "locked" in postion when the
[P+] button is pressed and only the
robot joint angles will move.

This button is also used for entering
the numerical value [3].

[P-/8] - Negative P / 8 button.

When used as [P-], this button moves
the robot hand section pivoting around
the wrist (pitch) joint, at the currently
selected jog speed setting in the
negative direction. In Point-to-point
Mode this is an downwards direction.
In XYZ grid Mode, the gripper reference
point is "locked" in postion when the
[P+] button is pressed and only the
robot joint angles will move.

This button is also used for entering
the numerical value [8].

POINT-TO-POINT MODE -
P+ AND P- DIRECTIONS.
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ROBOT KEYPAD -
[R+/2] & [R-/7]
BUTTONS.

[R+/2] - Positive R / 2 button.

When used as [R+], this button rotates
the robot hand section pivoting around
the wrist (roll) joint, at the currently
selected jog speed setting in the
positive direction. In Point-to-point
Mode and XYZ grid Mode the wrist
rotates in a clockwise direction, when
viewed from the front of the   grippers.

This button is also used for entering
the numerical value [2].

[R-/7] - Negative R / 7 button.

When used as [R-], this button rotates
the robot hand section pivoting around
the wrist (roll) joint, at the currently
selected jog speed setting in the
negative direction. In Point-to-point
Mode and XYZ grid Mode the wrist
rotates in an anticlockwise direction,
when viewed from the front of the
grippers.

This button is also used for entering
the numerical value [8].

POINT-TO-POINT MODE -
R+ AND R- DIRECTIONS.
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ROBOT KEYPAD -
[1] & [6]
BUTTONS.

[1] - 1 button.

This button is used for entering the
numerical value [1].

The [OPTION] and [+] functions are
unavailable.

[6] - 6 button.

This button is used for entering the
numerical value [6].

The [OPTION] and [-] functions are not
supported by the VR Linker.
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ROBOT KEYPAD -
[<O>/Ø] &
[>C</5]
BUTTONS.

[>C</5] - Close gripper / 5 button.

When used as [>C<], this button
closes the robot grippers.

This button is also used for entering
the numerical value [5].

[<O>/Ø] - Open gripper / Ø button.

When used as [<O>], this button
opens the robot grippers.

This button is also used for entering the
numerical value [Ø].
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ROBOT

KEYPAD - NON

FUNCTIONING

BUTTONS.

[TRN] button.
[STEP] button.
The functions on the buttons listed
above are not supported on the Robot
Teachbox, since their functions are
supported in other areas of the
software.
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The Robot Arm is moved using the buttons on the
Robot Teachbox. To display the robot teachbox
window, check the name of the robot you want to
control is shown in the "DEVICE" dialog box of the VR
Linker window (shown below). Press the [C] button to
display the robot teachbox.

DISPLAYING THE

ROBOT TEACHBOX

& NESTING THE

ROBOT.

Click the On/Off switch on the robot teachbox to switch
it "on". The robot must be nested (datumed) before
jogging the robot to position or commanding any moves.

In Virtual Reality, the robot will automatically nest when
the mains power is switched "on" (the switch on the
grey rectangular electrical control box).In this
particular case, the robot need not be manually nested.

When the robot teachbox has been switched "off",
then switched back "on" again, you must manually
nest the robot. Click the [NST] button followed by the
[ENT] button. The robot will then move to its datum
position.

[C] BUTTON DISPLAYS

ROBOT TEACHBOX WINDOW

NAME OF DEVICE CURRENTLY

BEING CONTROLLED

[ENT]
BUTTON

[NST]
BUTTON
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You can move the robot quickly using the mouse.

Simply click and hold down the left mouse button when
the cursor is directly over the axis you want to
control. Drag the cursor in the direction you want the
robot to move. To stop the robot moving, release the
left mouse button.

As the cursor is dragged further away from the robot
axis, the the robot part under control will move faster.

Click and drag the robot in the following areas, shown
in the diagram below:

MOVING THE

ROBOT WITH

THE MOUSE.

CLICK HERE

TO OPEN/
CLOSE THE

GRIPPERS

CLICK AND

DRAG HERE

TO ROTATE

THE WRIST

CLICK AND

DRAG HERE

TO MOVE THE

WRIST DOWN

CLICK AND DRAG HERE

TO MOVE THE WRIST UP

CLICK AND DRAG HERE TO MOVE

THE FOREARM SECTION UP/DOWN

CLICK AND DRAG HERE TO

MOVE THE UPPERARM

SECTION UP/DOWN

CLICK AND

DRAG HERE TO

ROTATE THE

ROBOT

CLOCKWISE/
ANTICLOCKWISE
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The robot can be moved using the following modes:
- PTP (Point-to-point) Mode.
- XYZ (grid) Mode.
- Tool Mode

SELECTING PTP
MOVEMENT

MODE.
[PTP] - POINT-TO-POINT MODE.
Point-to-point Mode instructs the virtual robot to jog
(move) using its individual joints (axes) when the
appropriate jog buttons are pressed:

[B+] & [B-]
[S+] & [S-]
[E+] & [E-]

For example, if the [Y+/S+] button is pressed when
the robot is set in PTP Mode, the button will be
recognised as [S+]. The upperarm section will move
in an upwards direction, pivoting around the shoulder
joint.

To select PTP Mode, click the [PTP] button on the
robot teachbox. All subsequent commands will be
performed in PTP Mode.

Note - The functions of the wrist movement buttons
are not affected by the setting of PTP Mode:
[P+] & [P-]
[R+] & [R-]

[PTP]
BUTTON

POINT-TO-POINT MODE -
S+ AND S- DIRECTIONS.To cancel PTP Mode,

click on one of the other
available movement
modes - XYZ or Tool.
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SELECTING XYZ
MOVEMENT

MODE.

[XYZ] - XYZ MODE.
XYZ Mode instructs the virtual robot to jog (move),
using the tip of its grippers as a reference point, for
moving around a three-dimensional X, Y and Z grid
system when the  appropriate jog buttons are pressed:

[X+] & [X-]
[Y+] & [Y-]
[Z+] & [Z-]

For example, if the [Y+/S+] button is pressed when
the robot is set in XYZ Mode, the button will be
recognised as [Y+]. The tip of the grippers will move
along the Y axis in a parallel and positive direction. All
the sections and joints of the robot move
independently of each other to keep the tip of the
grippers as close to this Y axis as possible.

To select XYZ Mode, click the [XYZ] button on the
robot teachbox. All subsequent commands will be
performed in XYZ Mode.

Note - The functions of the wrist movement buttons
are not affected by the setting of XYZ Mode:
[P+] & [P-]
[R+] & [R-] XYZ MODE -

Y+ AND Y- AXES DIRECTIONS.

+Y

+X
+Z

3D GRID.

Y+

Y-

[XYZ]
BUTTON

To cancel XYZ Mode,
click on one of the other
available movement
modes - PTP or Tool.
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SELECTING

TOOL
MOVEMENT

MODE.

[TOOL] - TOOL MODE.
Tool Mode instructs the virtual robot hand to advance
or retract at a fixed height, in the direction in which
the hand is pointing (ie, the robot base "locks" in
position and does not move).

Tool Mode is not a general movement mode. It should
be used for accurate positioning of the robot hand in a
horizontal plane. The attitude/angle of the robot hand
is fixed at the point when Tool Mode is selected.

Tool Mode operates using the following jog (move)
keys:

[Z+] & [Z-]
[R+] & [R-]

For example, pressing the [Z+] button when the robot
is set in Tool Mode will extend the robot hand out
(away from the base of the robot) in the direction in
which it is facing. Following the setting of Tool Mode,
the robot arm will try to maintain the height and angle
of the robot hand.

To select Tool Mode, click the [TOOL] button on the
robot teachbox. All subsequent commands will be
performed in Tool Mode.

[TOOL]
BUTTON

TOOL MODE -
Z+ AND Z- DIRECTIONS.

Z+ Z-
HORIZONTAL
MOVEMENT

BASE "LOCKED"
IN POSITION

To cancel Tool Mode,
click on one of the other
available movement
modes - PTP or XYZ.
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MOVING THE

ROBOT.
Once the Movement Mode has been selected, the
robot can be moved manually, using the movement
keys on the righthand side of the robot teachbox (see
panel below left).

The speed at which the robot moves when being
manually positioned is determined by the Jog Speed
setting. To display the current jog speed, click on the
"Options" menu in the menubar of the robot teachbox
(shown below as a Jog Speed of 6).

To change the jog speed, click "Options|Jog Speed"
in the toolbar of the robot teachbox window. Adjust
the slider until the required jog speed is shown, then
press the [OK] button (shown below).

[MOVEMENT]
BUTTONS

Jog speed - 1 is slow but very accurate at positioning,
whilst Jog Speed - 9 is fast but inaccurate when
positioning.
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SETTING AND

MOVING TO A
STORED ROBOT

POSITION.

As the robot is manually moved, any positions reached
can be stored in its memory. The Robot Memory can
store between 1 - 629 robot positions (each with a
corresponding 001 - 629 position number and a
written description). The entire robot memory can be
saved, to be edited or used by a robot program at a
later date.

Click on the "Memory" menu in the robot teachbox
menubar and check that the "Use Memory
Descriptions" and the "Warn If Position Exists"
options are switched "on" (indicated by a tick mark).

Click on each option to switch it "on" or "off" (shown
below).
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[PS]
BUTTON

[MOV]
BUTTON

[ENT]
BUTTON

[NUMBERS]
BUTTONS

To store the current robot position, click the [PS]
button, position set, on the robot teachbox.

Enter a three digit number beteween ØØ1 and 629,
using the robot teachbox [NUMBERS] buttons and click
on the [ENT] button. The numbers being entered will
appear on the robot teachbox display.

If position number already exists a warning message
will be diaplayed (shown below). Click the appropriate
button to overwrite the existing position, or retype with
a different position number.

The Robot Position Description window will appear
(shown below). Type in a written description for the
robot position, then click the [OK] button to store the
robot position in its memory.

Note - To view the entire list of currently stored robot
positions click "Memory|Edit Memory..." in the robot
teachbox menubar.

To move the robot to a position previously stored in its
memory, click the [MOV] button on the robot teachbox.

Enter the number of the position you want the robot to
move to, using the [NUMBERS] buttons, then click the
[ENT] button. The robot will now move to this "new"
position.

SETTING AND

MOVING TO A
STORED ROBOT

POSITION.



MOVING AND STORING ROBOT POSITIONS  -  9.9VIRTUAL REALITY ROBOT - USER'S MANUAL

SAVING THE

ROBOT

MEMORY.

It is important to save the Robot Memory if you want
to edit any of the robot positions at a later date or if
the robot positions are used by a  robot script file.

To save the robot memory file, click "Memory|Save
memory to..." in the robot teachbox menubar (shown
below).

The Save As window is displayed, allowing the robot
memory file (file extension ".RTF") to be saved to a
set location.
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STARTING THE

ROBOT SCRIPT

FILE EDITOR.

The Robot Script File Editor is used to build robot
programs (called robot script files), constructed from
the robot position numbers stored in the robot memory.
A robot script file describes the move sequences and
functions required by the robot to perform a set task.

Saved robot script files can be sent to the virtual robot
and/or a "real" robot connected to the computer.

Note - The Robot Memory File (containing all the stored
robot positions used in the robot script file) must be
loaded into the virtual robot and/or downloaded to the
"real" robot before the robot script file is run.

To display the Robot Script File Editor window, click
on "Scripts|Edit Script..." from the menubar on the
Robot Teachbox window (shown below).
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ROBOT SCRIPT

FILE EDITOR -
GENERAL

LAYOUT.

ROBOT SCRIPT FILE EDITOR WINDOW - GENERAL LAYOUT.

1) FILE MENU. 3) ROBOT SCRIPT FILE DISPLAY WINDOW.

6) [OK] AND

[CANCEL]
BUTTONS.

5) ROBOT SCRIPT

FILE [PLAY]
BUTTONS.

4) ROBOT SCRIPT FILE

[LINE EDITING]
BUTTONS.

2) OPTIONS MENU.
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ROBOT SCRIPT

FILE EDITOR -
FILE MENU.

The Script File Editor contains the following:

1) The File Menu (shown below) - The options
available in the File menu are as follows:

� New - Starts a new (blank) Robot Script File.

� Open - Displays the Open file window. Browse
and open any previously saved (".TXT" format)
robot script files.

� Save - Autosave and overwrite a robot script file
with the last used filename.

� Save As - Displays the Save robot script file win-
dow, allowing the file to be saved with a specific
filename in a specific directory.

� Send Program to Real Robot - This option is greyed
out (unavailable) unless a "real" robot is connected
to your computer.

� Receive Program from Real Robot - This option is
greyed out (unavailable) unless a "real" robot is
connected to your computer.

continued....

LOCATION OF THE ....
FILE MENU.
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ROBOT SCRIPT

FILE EDITOR -
FILE MENU AND

OPTIONS MENU.

1) The File Menu continued....

� History - Displays the history of any robot script
files opened.

� Exit - Closes the robot script file file editor
window without saving any changes.

LOCATION OF THE ....
OPTIONS MENU.

2) The Options Menu (shown below) - The options
available in the Options menu are as follows:

� Configure - Displays the Robot Script Options
window (shown below), allowing selected areas of
the Robot Script Editor to be arranged to suit the
user.

continued....
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ROBOT SCRIPT

FILE EDITOR -
OPTIONS MENU.

2) The Options Menu continued....

The Robot Script Options window contains the
following:

� Automatically build comments - Automatically
inserts comments describing the actions occuring
in the line currently being programmed.

Click in the box to switch the option on/off. A
"tick mark" is visible when the option is switched
"on".

� Start line numbers from box - The first line of
any "new" (blank) robot script file begins with
this number. Use the arrow buttons to increase
or decrease the number.

� Number spacing for lines box - Shows the
number of blank lines that are inserted following
the completion of the current robot script file line.
Note, the blank lines are not shown on the robot
script file display window.

For example, if the current line being edited is 4Ø
and this option is set to 15, the next program
lines are numbered as follows: 55, 6Ø, 75 etc.

Use the arrow buttons to increase or decrease
the number.

continued....

LOCATION OF THE ....
OPTIONS MENU.
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2) The Options Menu (Robot Script Options window)
continued....

� Number of seconds to add after a gripper
operation box - When set at 1 or higher, this
option automatically inserts a new robot script
file line containing a "TI" wait command, after
any line containing a gripper operation. The length
of time waited before continuing to the next
robot script file line is determined by the number.

For example, if the number is 5, then a 5 second
wait is auomatically inserted after any gripper
operation command.

When the number is Ø (zero), no wait command
will be added after any gripper operation
command is completed.

Use the arrow buttons to increase or decrease
the number.

� Automatic gripper state - Automatically inserts
the letter "O" when the gripper is open or "C"
when the gripper is closed, in the gripper state
column of the robot script file display.

When the option is switched "on", it
automatically recognises any change in the
gripper state and updates the gripper state
column accordingly.

Click in the box to switch the option on/off. A
"tick mark" is visible when the option is switched
"on".

� [OK] button - Applies any changes made and
closes the Robot Script Options window.

� [Cancel] button - Ignores any changes made
and closes the Robot Script Options window.

ROBOT SCRIPT

FILE EDITOR -
OPTIONS MENU.

LOCATION OF THE ....
OPTIONS MENU.
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3) The Robot Script File Display Window  (shown
below) - The robot script file display window shows
detailed information about each line of the robot
script.

The display is split into five columns. When the
robot script file exceeds the height of the display
window, a scroll bar is automatically added to the
righthand side of the window. Click and drag the
slider, or click on the up/down arrow buttons to move
between different areas of the robot script file.

Note that the information and layout of the robot
script file can be changed using the Robot Script
Options window, accessible by clicking
"Options|Configure..." in the menubar of the main
Robot Script window.

ROBOT SCRIPT

FILE EDITOR -
ROBOT SCRIPT

FILE DISPLAY

WINDOW.

LOCATION OF THE ....
ROBOT SCRIPT FILE

DISPLAY WINDOW.

GRIPPER

STATE

COLUMN.

continued....

LINE

NUMBER

COLUMN.

ACTION

COMMAND

COLUMN.

LINE

DESCRIPTION

COLUMN.

ACTION

INFORMATION

COLUMN.
SCROLL

BAR.
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3) The Robot Script File Display Window  continued....

The five columns of the robot script file display list
as follows (from left to right on the display):

� Column 1 (Line Number box) - Displays the line
number of the robot script file.

� Column 2 (Action Command box) - Displays
the shorthand for the action or operation to be
performed. Action commands can be chosen and
edited from a pop-up list, accessible by
highlighting the required action command box,
clicking with the right mouse button, then
selecting one of the options:

Move to Position (MO) -  Move the robot to a
position stored in its memory.

Robot Speed (SP) - Set the speed at which the
robot performs any action commands. This speed
setting continues for all program lines until
overridden by a "new" speed.

Open Grippers (GO) - Open the robot grippers.

Close Grippers (GC) - Close the robot grippers.

Goto Line (GT) - Goto the robot script file line
number that you specify from the pop-up list.

Do Sub-routine (GS) - Perform a sub-routine.
Available preset sub-routines for virtual reality can
be chosen from a pop-up list (Note - "real" sub-
routines are normally written by the user and
contain an "RT" return command).

Wait Time (TI) - Perform a time delay, specified
in seconds from the pop-up list, before
continuing to the next robot script file line.

Nest Robot (NST) - Move the robot back to its
datum position.

continued....

ROBOT SCRIPT

FILE EDITOR -
ROBOT SCRIPT

FILE DISPLAY

WINDOW.

LOCATION OF THE ....
ROBOT SCRIPT FILE

DISPLAY WINDOW.
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continued....

� Column 3 (Action Information box) - Displays
information relating to the action command, ie,
the length of waiting time for a "TI" command,
or the robot position number for a "MO" move
command. Action information can be chosen and
edited from a pop-up list, accessible by highlight-
ing the required action information box, clicking
with the right mouse button, then selecting one
of the options.

� Column 4 (Gripper State box) - Displays the
current state of the robot grippers. "O" for open
grippers and "C" for closed grippers. The gripper
state can be chosen and edited from a pop-up
list, accessible by highlighting the required grip-
per state box, clicking with the right mouse but-
ton, then selecting one of the options (Gripper
Open, Gripper Closed or None).

� Column 5 (Line Description box) - Displays text
describing the function of each robot script file
line. The information in the line description box
can be edited by clicking in the box then
overtyping with new text.

continued....

ROBOT SCRIPT

FILE EDITOR -
ROBOT SCRIPT

FILE DISPLAY

WINDOW.

LOCATION OF THE ....
ROBOT SCRIPT FILE

DISPLAY WINDOW.
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continued....

4) The Robot Script File [Line Editing] buttons (shown
below) - Use these three buttons to edit the
currently highlighted robot script file line.

The three buttons list as follows (from left to right
on the window):

� [Add] - Inserts a "new" (blank) robot script file
line, after the last line in the robot script file.

� [Insert] - Inserts a "new" (blank) robot script
file line, directly after the line currently highlighted.

� [Delete] - Permanently removes the robot script
file line currently highlighted.

continued....

ROBOT SCRIPT

FILE EDITOR -
[LINE EDITING]
BUTTONS.

LOCATION OF THE ....
ROBOT SCRIPT FILE [LINE

EDITING] BUTTONS.
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ROBOT SCRIPT

FILE EDITOR -
[PLAY] BUTTONS.

LOCATION OF THE ....
ROBOT SCRIPT FILE

[PLAY] BUTTONS.

continued....

5) The Robot Script File [Play] buttons (shown below)
- There are four robot script file play buttons:

            [PLAY]  [PAUSE]  [STOP]  [REWIND TO START]

� [Play] - Click this button to play the  robot script
file from the currently highlighted robot script line
onwards. As the the robot script file plays, line
by line, the stated actions will be performed by
the devices in the virtual world.

� [Pause] - Click this button to pause a robot
script file that is playing. Click the [Pause] button
to resume playing a paused robot script file.

� [Stop] - Click this button to stop the robot script
file playing, at the end of the robot script line
currently being performed.

� [Rewind to Start] - Click this button to return
to the first robot script line of the robot script
file.

Note - The [Play] button is greyed out (unavailable) when
the robot teachbox is operational, ie, a robot script file
cannot be played when the robot teachbox switched "on".

continued....
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ROBOT SCRIPT

FILE EDITOR -
[OK] AND

[CANCEL]
BUTTONS.

continued....

6)The [OK] and [Cancel] buttons (shown below).

The [OK] button - Click the [OK] button to apply
and/or save any changes made to the robot script
file and close the robot script file editor window.

The [Cancel] button - Click the [Cancel] button to
close the robot script file editor window without
saving any changes.

LOCATION OF THE ....
[OK] AND [CANCEL]

BUTTONS.

EXAMPLE ROBOT

SCRIPT FILE.
A detailed example, showing how a robot script file is
generated using the robot script file editor, is included
in Section 2 - Quickstart Tutorial.
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ROBOT SCRIPT

FILE EDITOR -
LOADING AN

EXEMPLAR

ROBOT SCRIPT

FILE.

Exemplar Robot script files can be loaded for each of
the five robot room virtual worlds.

The exemplar files are stored in the user folder
"10000". There are five of these folders, one in each
of the individual robot room folders (Room 81 - 85).

First, load the robot memory that contains all the
robot positions required by the robot script file. The
robot memory file (".RTF" format) is loaded by
clicking on "Memory|Load memory from..." in the
menubar of the robot teachbox window. Browse and
open the correct room folder, then the folder labelled
"10000" and load the exemplar robot memory file.

Next, click on "Scripts|Edit Script..." in the menubar
of the Robot Teachbox window to display the Robot
Script window.

Click on "File|Open" in the menubar of the Robot Script
window. Browse and open the same room folder used
for loading the robot memory file, then the folder
labelled "10000"and load the exemplar robot script
file (".TXT" format).

Check that the Robot Teachbox is switched "off" to
allow access to the [Play] button of the robot script
file window.

Click the [Rewind to Start] button, then the [Play]
button on the control panel of the Robot Script
window, to start the program.



10.14  -  THE ROBOT SCRIPT FILE EDITOR VIRTUAL REALITY ROBOT - USER'S MANUAL



THE FIVE VIRTUAL WORLD ROBOT ROOMS  -  11.1VIRTUAL REALITY ROBOT - USER'S MANUAL

ROBOT ROOM

STARTING POINT.
THE LIFT.
You start each virtual world robot room from within a
lift.

Click on the lift doors to open or close them.

To load a new robot room hit the appropriate floor
button on the lift control panel (ie, floor button 4 loads
virtual world  robot room 4).

To close the currently loaded virtual world robot room
at any time, click on the floor button Ø (zero) on the
lift control panel.

TO OPEN AND

CLOSE LIFT DOORS,
CLICK ON THEM.

LIFT CONTROL PANEL

(LOADS AND CLOSES

ROBOT ROOMS).
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ROOM 1 TASK.
Room 1 contains a table with the robot upon it. On
opposite sides of the robot are a collection of four
coloured ink well squares and a block holding a pencil.

When each of the surfaces of the coloured ink well
squares is touched, a sound is triggered. There are
four different sounds, one for each of the coloured ink
well squares.

VR ROBOT

ROOM 1 TASK.

RESET

BLOCK.

The task in room 1 is to program the robot so it picks
up the pencil and then moves across to the coloured
ink well squares. The robot must then be programmed
to touch each of the four coloured ink well squares
with the pencil, triggering the sounds.

PENCIL IN
BLOCK.

FOUR COLOURED INK

WELL SQUARES.
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VR ROBOT

ROOM 1
INTELLIGENT

OBJECTS.

INTELLIGENT OBJECTS.
By positioning the cursor over some of the objects in
robot room 1, then clicking the mouse buttons,
certain moves and operations can be implemented.

Right mouse click on the pencil in the block - Moves
the robot so the grippers are opened and positioned
around the pencil (ready to pick up pencil).

Left mouse click on the pencil when held by the robot
grippers - Moves the robot so the pencil is held
directly over the block (the grippers remain closed).

Left mouse click on the
pencil in the block (shown
left) - Moves the robot so
the grippers are opened
and positioned directly
above the pencil (ready to
approach pencil).
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HINTS AND TIPS.
Many of the hints and tips listed here apply to the
other four robot rooms.

The viewpoints are designed to help you navigate
quickly around important parts of the robot room. They
can also contain help on what to do at each viewpoint
(shown below).

The electrical control box (which switches the power
to the robot on and off) is positioned on the floor in
front of the table.

When setting each robot position - it is quicker to move
the robot to roughly the right position by using the
mouse (click and drag the appropriate part of the arm),
then accurately position the arm using the teachbox
jog buttons.

VR ROBOT

ROOM 1 HINTS

AND TIPS.
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VR ROBOT

ROOM 1 HINTS

AND TIPS.

If you drop the pencil when
positioning the robot, click on the
yellow and black diamond (shown
left) - this resets all the objects back
to their default positions (robot
position excluded).

Give each robot position a relevant description name
and a complimentary robot position number. For
example, robot positions near the blue ink well are
numbered 1xx, robot positions near the red ink well
are numbered 2xx etc.... This will make it easier to
find robot positions when building a program with the
robot script file editor.

Try to store robot positions that can be used more
than once. For example, a robot position is stored at a
set height above the ink well dividing walls and
directly over the blue ink well. It could be used as a
robot approach position before dipping the pencil into
the ink well and as a return position for coming back
out from the ink well to a safe height.

Use the intelligent objects feature to help set some of
the robot positions.

Use the robot script file editor to build a program that
completes the set task. To start writing a robot script
file, click on "File|New" from the robot script file
editor menubar. When writing a robot script file, the
robot does not require datuming, since it
automatically nests when it is first switched on.
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The first task in room 2 is to program the robot so it
removes each of the cubes from the dispensing point
at the base of the hopper, then moves and stacks these
cubes on the drop off block to form a six cube column.

After completing task 1, reset the room by clicking on
the yellow and black diamond reset block.

The second task in room 2 is to program the robot so
it removes each of the cubes from the dispensing point
at the base of the hopper, then moves and builds three
columns, each containing two identically coloured
cubes, next to the drop off block.

VR ROBOT

ROOM 2 TASK.
ROOM 2 TASK.
Room 2 contains a table with the robot upon it. On
opposite sides of the robot are a drop off block and a
hopper containing six cubes.

RESET

BLOCK ON

THIS SIDE.

HOPPER

CONTAINING

6 CUBES.

DROP

OFF

BLOCK.
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VR ROBOT

ROOM 2
COLLISION

DETECTION.

COLLISION DETECTION.
The objects in robot room 2 are designed with
collision detection. This means if you drop a cube it
will fall, hit and roll on the table surface in a realistic
way. Dropped cubes can be pushed and picked up by
the robot arm.

Similarly, with collision detection active, the robot arm
will not move "through" the table and hopper. On
hitting the table or the hopper a sound will be emitted
and the robot arm will stop moving.

Robot room 2 starts, by default, with collision
detection active. Collision detection can be switched
on (tick mark visible) or off (tick mark invisible) by
clicking on "Options|Collision Detection" in the
menubar of the robot teachbox window (shown
below).
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VR ROBOT

ROOM 2
INTELLIGENT

OBJECTS.

INTELLIGENT OBJECTS.
By positioning the cursor over some of the objects in
robot room 2, then clicking the mouse buttons,
certain moves and operations can be implemented.

Left mouse click on the hopper dispensing point (the
purple section of the hopper) - Moves the robot so the
grippers are positioned facing the hopper dispensing
point (ready to approach cube). The angle of the robot
arm is also automatically set to allow a cube to be
easily and safely removed from the hopper dispensing
point. The gripper state will be left according to the
previous move.

Left mouse click on a cube not in the hopper - Moves
the robot arm so it is positioned directly over the cube
with the robot grippers open (ready to pick up the cube).

Right mouse click on a
cube at the hopper
dispensing point (shown
left) - Moves the robot
arm into the hopper
dispensing point and
opens the grippers so
they are positioned
around the cube in the
hopper (ready to remove
the cube).
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VR ROBOT

ROOM 3 TASK.
ROOM 3 TASK.
Room 3 contains three yellow and black striped floor
grids and a colour sequence code mounted on the wall.
Clicking on a striped floor grid activates the hydraulic
table   directly above it, which lowers from the ceiling.
All three tables contain the same items - an electrical
control box, a robot and a nine position colour keypad,
used as a security switch.

ROOM

TASK

TIMER.

TABLE CONTAINING

CONTROL BOX,
ROBOT AND KEYPAD.

TABLE

ACTIVATION

FLOOR GRID.

COLOUR

SEQUENCE

CODE.

continued....
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VR ROBOT

ROOM 3 TASK.
continued....

Opening the lift doors activates an "intruder alarm".
The task in room 3 is to deactivate the "intruder alarm"
in the shortest possible time - a timer is positioned on
the wall furthest from the lift doors.

To switch off the "intruder alarm" you must enter the
correct colour sequence code into the nine position
colour keypads on all three robot tables. To lower the
robot tables, click on each of the striped floor grids.
The colour sequence code (read from left to right) to
successfully deactivate the "intruder alarm" is stated
on a wall panel.

The colour sequence code must be entered one colour
at a time, for each of the three robot tables.
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VR ROBOT

ROOM 3
INTELLIGENT

OBJECTS.

INTELLIGENT OBJECTS.
By positioning the cursor over some of the objects in
robot room 3, then clicking the mouse buttons,
certain moves and operations can be implemented.

Note - Only table 1 has intelligent objects.

Left mouse click on a
keypad button (shown
left) - Moves the robot so
the grippers are positioned
directly over the keypad
button chosen.

Right mouse click on a
keypad button - Moves
the robot so the grippers
press the kepad button
chosen.

Left mouse click on the grey keypad block (not one of
the nine buttons) - Moves the robot to a safe
clearance position. The clearance position is ideal for
returning from or moving closer to the keypad
buttons.
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HINTS AND TIPS.
The colour sequence code must be entered one colour
at a time, for each of the three robot tables in turn.

For example, if the first two numbers of the colour
sequence code are yellow, blue.... then robots 1,2 and
3 must move in the following order to begin
deactivating the "intruder alarm":

- Robot 1 touches the yellow button on its keypad.
- Robot 2 touches the yellow button on its keypad.
- Robot 3 touches the yellow button on its keypad.
- Robot 1 touches the blue button on its keypad.
- Robot 2 touches the blue button on its keypad.
- Robot 3 touches the blue button on its keypad.
- This continues for all the other required colours
until the sequence has been completed.

Completing the entire colour sequence on robot 1, then
robot 2 and finally robot 3 will not deactivate the
"intruder alarm".

Only table 1 has intelligent objects. Tables 2 and 3 do
not have any intelligent objects for a good reason....

The task requires you to program all the robots so that
they press the keypad buttons in the correct sequence,
in order to deactivate the "intruder alarm".

Once robot 1 has been programmed to press the keypad
buttons in the correct order, robots 2 and 3 must also
be programmed to press their keypad buttons in the
same order as for robot 1 (since the deactivate code is
the same for all three keypads).

Therefore, the memory for robot 1 can be saved and
reloaded as the memory for robots 2 and 3. Similarly,
the robot script files for robots 2and 3 will be identical
to those for robot 1.

continued....

VR ROBOT

ROOM 3 HINTS

AND TIPS.
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continued....

Set all the required robot positions to complete the
deactivation of the "intruder alarm" into the memory
of robot 1, then save this memory file.

Next, open the robot script file editor and click on
"File|New" from its menubar. Write and save the
robot script files for all the moves required to
complete the colour sequence code. For example:

- Move robot arm from parked position to safe
position over keypad.
- Move robot arm down, press first colour button
required, move back to safe position.
- Move robot arm down, press second colour button
required, move back to safe position.
- Move robot arm down, press third colour button
required, move back to safe position.
- Move robot arm down, press fourth colour button
required, move back to safe position.
- Move robot arm down, press fifth colour button
required, move back to safe position.
- Move robot arm from safe position over keypad to
parked position.

Close the Robot teachbox window (currently
controlling robot 1).

Switch on robot 2 and change the devices panel of VR
Linker so it displays Robot 2. Load the robot memory
(previously saved from robot 1) into robot 2.

Close the Robot teachbox window (currently
controlling robot 2).

Switch on robot 3 and change the devices panel of VR
Linker so it displays Robot 3. Load the robot memory
(previously saved from robot 1) into robot 3.

Now all three robots have identical memories loaded
with all the positions required to complete the
deactivation of the "intruder alarm"

continued....

VR ROBOT

ROOM 3 HINTS

AND TIPS.
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continued....

Change the DEVICES panel of VR Linker so it displays
Robot 1. Click the [E] button in the ACTIONS panel of
the VR Linker window to display the Action Editor
window. Now add all the previously saved robot script
files into the Action Editor, including appropriate
descriptions to help identify them later.

When the Actions Editor window is closed, the list of
actions available for robot 1 can be viewed using the
dropdown list button in the ACTIONS panel of the VR
Linker   window.

Repeat the same process for robots 2 and 3 (by
changing the DEVICES panel of VR Linker so it
displays Robot 2 or 3). The robot script files written
for use with robot 1 can also be used in the Actions
Editor for robots 2 and 3.

Now all three robots have identical action lists in the
VR Linker window.

Next, open the sequence file editor and click on
"File|New" from its menubar. Use the actions from all
three robots together, to produce sequence of events,
occurring in the correct order to deactivate the
"intruder alarm". Test and save the completed
sequence file.

Reload robot room 3, switch on all three robots and
load their memories, then load and run your saved
sequence file. How quickly can you deactivate the
"intruder alarm"?

VR ROBOT

ROOM 3 HINTS

AND TIPS.



THE FIVE VIRTUAL WORLD ROBOT ROOMS  -  11.15VIRTUAL REALITY ROBOT - USER'S MANUAL

To complete both the tasks below, the robot must
avoid hitting any parts of the obstacle blocks with
itself or any of the cubes being moved.

The first task in room 4 is to program the robot so it
removes each of the cubes from the dispensing point
at the base of the hopper, then moves and stacks these
cubes on the drop off block to form a six cube column.

After completing task 1, reset the room by clicking on
the yellow and black diamond reset block.

The second task in room 2 is to program the robot so
it removes each of the cubes from the dispensing point
at the base of the hopper, then moves and builds three
columns, each containing two identically coloured
cubes, next to the drop off block.

VR ROBOT

ROOM 4 TASK.
ROOM 4 TASK.
Room 4 contains a table with the robot upon it. On
opposite sides of the robot are a drop off block and a
hopper containing six cubes. The robot is also partially
surrounded by obstacle blocks.

RESET

BLOCK.
HOPPER CONTAINING

6 CUBES.
DROP OFF

BLOCK.

OBSTACLE

BLOCKS.
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VR ROBOT

ROOM 4
COLLISION

DETECTION AND

INTELLIGENT

OBJECTS.

COLLISION DETECTION.
The objects in robot room 4 are designed with
collision detection. This means a sound will be emit-
ted and the robot will stop moving if it hits any of the
obstacles, the hopper or the table. The hopper cubes
can also be dropped, pushed and picked up.

Robot room 4 starts, by default, with collision
detection active.

INTELLIGENT OBJECTS.
By positioning the cursor over some of the objects in
robot room 2, then clicking the mouse buttons,
certain moves and operations can be implemented.

Left mouse click on the hopper dispensing point (the
purple section of the hopper) - Moves the robot so the
grippers are positioned facing the hopper dispensing
point (ready to approach cube). The angle of the robot
arm is also automatically set to allow a cube to be
easily and safely removed from the hopper dispensing
point. The gripper state will be left according to the
previous move.

Left mouse click on a cube not in the hopper - Moves
the robot arm so it is positioned directly over the cube
with the robot grippers open (ready to pick up the cube).

Right mouse click on a cube at the hopper dispensing
point - Moves the robot arm into the hopper
dispensing point and opens the grippers so they are
positioned around the cube in the hopper (ready to
remove the cube).
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ROOM 5 TASK.
Room 1 contains a robot mounted upon a column, six
posts holding blank billets and a Denford Mirac CNC
lathe.

VR ROBOT

ROOM 5 TASK.

The task in room 5 is to program the robot so it picks
up and places each blank billet into the lathe, then
retreats to a safe parked position.

The lathe must be programmed to manufacture a
component, using a program relating to the blank billet post
colour (eg, a blank billet from the blue post would be used to
make the blue component design). The robot must then
remove and return the component to its original post.

This sequence of events must be repeated until all
six different example components have been
manufactured. Examples of the six components to be
made are shown on top of the lathe cabinet.

DENFORD MIRAC

CNC LATHE.
BLANK BILLETS ON

STORAGE POSTS.
ROBOT MOUNTED

ON COLUMN.
EXAMPLE

COMPONENTS.
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VR ROBOT

ROOM 5
INTELLIGENT

OBJECTS.

INTELLIGENT OBJECTS.
By positioning the cursor over some of the objects in
robot room 5, then clicking the mouse buttons,
certain moves and operations can be implemented.

Left mouse click on a
billet (shown left) - Moves
the robot  so the grippers
are open and positioned
directly above the billet
(hand horizontal ready to
approach billet).

Right mouse click on a
billet - Moves the robot
so the grippers are open
and positioned around the
billet (hand horizontal
ready to pick up billet).

Click on the grippers to close them around the billet.

Left mouse click on a billet post - Moves the robot  so
the grippers remain closed around a billet previously
picked up to a position directly above the billet post
(hand horizontal ready to lower billet onto post).

Right mouse click on a billet post - Moves the robot
so the grippers remain closed around a billet
previously picked up tand places the billet onto the
billet post (hand horizontal ready to release billet onto
the post).

continued....
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VR ROBOT

ROOM 5
INTELLIGENT

OBJECTS.

continued....

Left mouse click on the
robot base - Moves the
robot to a safe position
(with the gripper state as
in the previous move).

Right mouse click on the
robot base (shown left) -
Moves the robot to a
position approaching the
lathe door aperature (with
the gripper state as in the
previous move).

Left mouse click on the lathe headstock (white panel
around the chuck) - Moves the robot with the gripper
state as in the previous move, to a position
approaching the chuck (billet aligned with spindle
centreline).

Right mouse click on the
lathe headstock (white
panel around the chuck)
- Places a billet held by
the robot grippers into the
lathe chuck (shown left).

continued....
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VR ROBOT

ROOM 5
INTELLIGENT

OBJECTS.
Left mouse click on the
lathe guard door - Opens
the lathe guard door.

Right mouse click on the
lathe guard door (shown
left) - Closes the lathe
guard door.

continued....

Left mouse click on the lathe chuck - Opens the lathe
chuck.

Right mouse click on the lathe chuck - Closes the lathe
chuck.

When a billet has been clamped in the chuck and the
lathe guard door closed, left mouse click on one of the
six example components (on top of the lathe cabinet).
The lathe will automatically manufacture the
component selected.
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VR ROBOT

ROOM 5 -
DISPLAYING THE

LATHE CONTROL

PANEL.

The Lathe Control Panel is used to operate some of
the functions on the virtual CNC lathe. Graphically,
the layout and appearance of this panel is identical to
the righthand section of a "real" Denford CNC lathe
control panel.

To display the lathe control panel window, check that
the DEVICE dialog box of the VR Linker window
displays the device name "lathe", then click the [C]
button to display the lathe control panel window.

2) CLICK THE [C] BUTTON

TO DISPLAY THE LATHE

CONTROL PANEL.

1) SELECT LATHE FROM THE

LIST OF AVAILABLE DEVICES.
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VR ROBOT

ROOM 5 - LATHE

CONTROL PANEL

GENERAL LAYOUT.

LATHE CONROL PANEL WINDOW - GENERAL LAYOUT.
CLOSE WINDOW

BUTTON.

TEXT DISPLAY WINDOW.

[DELETE] BUTTON.

[EOB] BUTTON.

[M] BUTTON.

[NUMBERS] BUTTONS.

VR ROBOT

ROOM 5 -
ENTERING AN

M CODE.

To enter an M code using the lathe control panel, click
on the [M] button - the "M" prefix will appear in the
text display window.

Click on the [Numbers] buttons to enter the two digit
M code number, again displayed in the text display
window. Use the [Delete] button to remove any
incorrect characters.

Finally, click on the [EOB] button to confirm and
execute the command.

continued....
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VR ROBOT

ROOM 5 -
ENTERING AN

M CODE.

The lathe control panel window contains the following
items:

� Close window button - Click the [X] button to close
the lathe control panel window.

� Text display window - Displays any commands,
messages or information from any buttons pressed
on the lathe control panel.

� [Numbers] buttons - Click on the ten numbers
buttons when entering M codes - each number is
displayed in the text display window.

� [M] button - Click on the [M] button to enter an M
code - the "M" prefix is displayed in the text display
window.

� [Delete] button - Click on the [Delete] button to
remove any incorrectly entered characters from the
text display window.

� [EOB] button - Click on the [EOB] button to confirm
and execute any requested M code command.

continued....

The following M codes can be executed using the lathe
control panel:

� M1Ø - Opens the lathe chuck.

� M11 - Closes the lathe chuck.

� M38 - Opens the lathe guard door.

� M39 - Closes the lathe guard door.
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VR ROBOT

ROOM 5 - THE

LATHE ACTIONS

LIST.

All the lathe actions required to complete the task in
room 5 are automatically added into the ACTIONS
panel, unlike the robot actions which must be
programmed and added to the ACTIONS panel by the
user (unless logged on as the Default User).

Click on the actions list button in the ACTIONS panel
of the VR Linker window, to display the dropdown list
of available actions for the lathe (shown below).

Highlight the required action and click the left mouse
button so it appears in the actions dialog box. Click
the [A] button to perform the stated action.

ACTIONS LIST BUTTON (CLICK

TO LIST AVAILABLE ACTIONS).

HIGHLIGHTED ACTION.
ACTIONS DIALOG BOX

(SHOWS CURRENTLY

SELECTED ACTION).
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HINTS AND TIPS.
Use the different viewponts to help you switch on,
then program, the robot and lathe.

The task can be made easier to manage by splitting it
into six separate sub-tasks. Each sub-task is used to
build a robot memory and robot script files specific to
the manufacture of a particular component design.

Note - Some of the robot script files could be common
to all six sub-tasks (ie, placing the blank billet into the
lathe from a safe robot position, removing the chess
piece from the chuck back to the robot safe position).

Set the robot positions and write robot script files for
placing the billet in and taking the component out of
the chuck, via a safe robot position. Remember to save
the robot memory and robot script files !! Enter these
robot script files into the ACTIONS panel of the VR
Linker by using the actions editor (click on the [E]
button in the VR Linker window).

Program each of the six sub-tasks (the sub-task
example shown is for the blue component) as shown
below:

Load the robot memory previously saved for placing
the billet in and taking the component out of the chuck.
You will now add more robot positions to this memory
file specific to manufacture of the blue component.

continued....

VR ROBOT

ROOM 5 HINTS

AND TIPS.
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continued....

Set the robot positions and write robot script files for
picking up the billet up from the blue post and placing
the blue component back onto the blue billet post.
Remember to save the new robot memory and robot
script files !! Enter the robot script files into the
ACTIONS panel of the VR Linker by using the actions
editor (click on the [E] button in the VR Linker
window).

Open the sequence file editor and click on "File|New"
from its menubar. Use the actions from the robot and
lathe to produce sequence of events that
manufactures the blue component.

When adding the "Run Program" action, you will be
prompted for the name of the CNC file to be loaded.
Use the file "blue.fnc", since it is the billet from the
blue post being used. Test and save the completed
sequence file.

The CNC files (format ".FNC") can be edited using
Windows Notepad:

- The Billet Type number refers to the profile that
will be cut - looking at the example components
from the front of the lathe, they number from right
to left as 1Ø (yellow), 2Ø, 3Ø, 4Ø, 5Ø, 6Ø and 7Ø
(blank billet).
- The time taken to machine the component can
also be edited, but must have a minimum value of
1ØØØ (1Ø seconds).

Repeat this procedure for programming the
manufacture of the other five component designs.

VR ROBOT

ROOM 5 HINTS

AND TIPS.
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